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Introduction to ProviderLink

Section | - Introduction to ProviderLink

1. What is ProviderLink?

Unique to the healthcare industry is our interdependence on each other. Rarely can a job be
performed without successful external communications. Before you can do your job, you must get
an authorization, signature, order, medical record, referral, form, bed availability, etc. from
someone else who typically does not report to you or even work for your organization. Herein lies
the fundamental healthcare administrative problem. We are interdependent on each other but not
necessarily accountable to each other.

ProviderLink is an Internet communications tool that allows you to communicate patient information
with other healthcare facilities or professionals. Instead of being tied to a particular fax machine or
telephone extension, you can access ProviderLink anywhere you have an Internet connection.

Any document, whether electronic or handwritten, or any other information about a patient can be
placed in the patient record and securely sent to recipients. As long as the document can be
printed or faxed, it can be loaded into ProviderLink and attached to a patient record.

Whether the organizations you communicate with are online with ProviderLink or not, you can use
ProviderLink to track any messages to or from them. For facilities that are online with ProviderLink,
every message you send to them appears on their computer screen. If the facility is not yet online,
you can still fax them messages and use ProviderLink's fax-back, cover sheet to have any replies
automatically routed back to the appropriate patient record. In either case, ProviderLink
streamlines all of your communications.

Whenever you are transmitting patient records, you should be concerned about security and
HIPAA compliance. ProviderLink helps customers with their HIPAA compliance. Every message
sent or received by ProviderLink is logged and is date/time stamped. You can see when a
message is sent, when it was read, and who read it. All messages are patient specific, meaning
they are logged with and follow the patient record. You will always be able to see the complete
patient history in ProviderLink. The data stored in ProviderLink is secure and backed up several
times each day.

2. Benefits of Using ProviderLink

Each organization and each department within an organization has different communication needs
and ProviderLink has features to address them all.

Here are a few benefits current customers of different types have enjoyed since coming online with
ProviderLink:

Hospitals

a. Utilization Review
- Less time spent faxing and on the phone
- Extensive history and audit trail

b. Discharge Planning
- Less time spent faxing and on the phone
- Electronically obtain prior authorizations from participating agencies
- Broadcast a referral (e.g., SNF, HME/DME, HHA, etc.) with just a few mouse clicks
- Referral replies are directly attached to the patient records

c. Business Office
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d. Electronically receive requests for medical records
- Respond to requests more quickly to shorten the A/R cycle

e. Outpatient Services
- Central fax server allows central processing of all physician orders
- Workflow management for outpatient processes
- Streamline internal communication processes in one workflow

Skilled Facilities
a. Receive referrals from hospitals electronically

b. Pager notification lets you know the moment a referral arrives

c. Electronically receive and process Medicaid authorizations and prior approval

d. Broadcast referrals to assisted living, rest homes, and other facilities

HME/DME
a. Manage physician signature collections for Certificates of Medical Necessity

® oo o

Payors

Electronically obtain Medicaid or private payor approval
Electronically store Medicare DMERC forms

Receive referrals from facilities electronically

Pager natification lets you know the moment a referral arrives

a. Lesstime managing faxes and on the phone
b. Create online authorizations and schedule upcoming reviews
c. Copy clinical information into your other systems

3. Conventions Used In This Guide

When introducing you to a new term, the term will appear in italics.

Using the mouse is key to effectively using ProviderLink. When the instructions say to
click, it refers to a single click of the left mouse button. This is the main difference of
navigating and working in ProviderLink as most commands require a single click.

There will be times when the instructions will ask you to double-click on items. This refers
to two rapid clicks of the left mouse button. Double-clicking in ProviderLink is relatively
rare.

The menu bar also plays a key role in navigating through ProviderLink. When you are
asked to use the menu bar, the instructions will include bold text and arrows like this:
Lookup > Facility.

The instructions may call for you to type some text into a field in ProviderLink. The text
you will be asked to type will appear in a special font: This is text you need to enter into a
field.

If you need to press a key on your keyboard, the text on the key will appear in a bold
special font. For example: press the Enter key.

When you need to click a link or a button on the screen, the link or button name will
appear in bold letters: click the Submit button.
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4. Icons And Notes

The icons and notes used in the margins will lend you insight as to how you may best use the
instructions as they are presented.

Icon How The Icon Is Used

a_ The target icon points to a useful tip or hint that may help you use ProviderLink
@\ more efficiently.

@ The Book icon helps to introduce an idea or concept for the first time.
1

5. How This Guide Is Organized

« Section 1 — Introduction To ProviderLink - This section gives a basic overall introduction
to ProviderLink and explains how to use this training guide to get the best results.

« Section 2 — The Hands-On Tour of ProviderLink section outlines the basics of navigating
through the ProviderLink system. You will apply the concepts you learn here throughout
your day-to-day procedures.

o Section 3 — The Using ProviderLink In Your Daily Work section describes how the
features of the ProviderLink system work and how each department's users can get the
most benefit from using them.

« Section 4 — The appendix section describes how to troubleshoot issues encountered
while using ProviderLink.
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Section Il - A Hands-On Tour Of ProviderLink

1. How Do | Access ProviderLink?

ProviderLink is a browser-based web application, meaning it runs completely in an Internet
browser requiring no additional hardware or software. You can access ProviderLink from virtually
any computer as long as it is connected to the Internet. While ProviderLink may work in other web
browsers, Microsoft Internet Explorer Version 6.0 or higher is recommended.

To Access ProviderLink:

1. Using a computer that is connected to the Internet, open a Microsoft Internet Explorer (IE)
window.

2. Inthe IE window Address bar, type https://healthcare.covisint.com and press the Enter key.
The Covisint login screen will appear.

3. Enter your User ID and Password.

\@ The Password is case-sensitive and, when you log in, you will need to enter it exactly as
= A\ you set it up. The system will prompt you to change your Password every 90 days.
4. Click Login. The Covisint Healthcare home page displays. In the left-hand menu, under
Secured Applications, click ProviderLink to launch the application, which opens in a new
window.

My Profile ' Support * @ © @ Logout A

healthcare (now)
secured by |

ProviderLink Support

Welcome to ProviderLink Customer Support

Covisint Healthcare Collaboration Center

iith ProwiderLink you can: . ﬁ
. . ™
F + Eliminate fax, phone, and traditional mail communications |Pr0VIl:|el'Lmk
a + G0 paper-free '

+ Bring accountability and efficiency inta your healthcare communications

s Have a single destination for online communications with your extended carmmunity

+ Web Based Training

rivers

+ Training Documents
3 = Receive email alerts when bulleting are published. Get started =

Status  Subject

From Publish Date

2. Logging Into ProviderLink

A. The First Time You Log In

After receiving email notification from your Security Administrator that you are registered, you must
log in to ProviderLink to complete the registration process.

1. Open Internet Explorer.

2. In the URL address bar, enter https://healthcare.covisint.com. The Covisint login screen
displays.

3. Enter your User ID and Password.
4. Click Login. The Covisint Healthcare home page displays.


https://healthcare.covisint.com/
https://healthcare.covisint.com/
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My Profile : Support @ ‘@ Logout A&

healthcare (now)
secured by |

Home Healthcare News ProviderLink Supporl

esk

Welcome to ProviderLink Customer Support

Wiith ProviderLink you can: . ﬁ
" . ™

¥ sen lications « Eliminate fax, phone, and traditional mail cormmunications |PrOVll:|eerk

poviderLink » G0 papet-free

nt Healthcare Collaboration Center

+ Bring accountability and efficiency inta your healthcare communications
+ Have a single destination For online communications with your extended community

+ Web Based Training

* ¥YP Drivers Recent News

+ Training Documents

O Receive email alerts when bulleting are published, Get started =

Status  Subject From Publish Date

5. In the left-hand menu, under Secured Applications, click ProviderLink to launch the
application. The ProviderLink Terms and Conditions of User Agreements screen displays.

User Agreement
ProviderLink
Terms and Conditions of Use Agreement

IMPORTAHNT - READ CAREFULLY: The ProviderLink Terms and Conditions of Use Agreement {TCUA) is a legal agreement
hetween you, an individual user (USER) , and ProviderLink, Inc. for use of the ProviderLink web based software service
{PRODULCT). The PRODUCT also includes any updates and supplements to the original PRODUCT initially accessed and used by
you. By accessing or otherwise using the PRODUCT, you agree to he bound by the terms and conditions of this TCUA which
apply to any use of the ProviderLink PRODUCT and violation of any of them will result in subsequent denial of access and use
to you. You agree and are obligated to regularly review the TCUA for changes and agree to those changes by continuing to use
the PRODUCT. i you do not agree, do not access or use the PRODUCT

6. Scroll down to the bottom of the screen and click Yes to accept the terms of the agreement.
The ProviderLink News screen displays.

7. Click Proceed to Application. You have now completed the registration process.

8. When you log in, if you are a multi-facility domain, ProviderLink will ask you to select your
facility.

ProviderLink ™

ol o

Choose a Facility
User Hame: BMILLER

Facility Hame: | CapeFearvallsgdC
Cap eyt
Capitolt edicalE quiprment
SeasideSNF

9. Next, you will choose a Work List View, which can be thought of as a caseload, or “in
basket.” The Work List Views are listed alphabetically. Click the View drop-down arrow to
select the work list you wish to view and then click the Submit button.
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Note: “All Work Lists” is a special view that displays all of the patient
ProviderLink ™ records in all of the work lists. Generally, it is not used as part of a
C & typical workflow.
User Hame: BMILLER
Facility Hame: | CapitelMedicalEquipment
View:|  [BEEE v
@ Medicare
NC Medicaid
Other Private Ing
All'work Lists

10. After selecting a Work List View, you will be taken to the Main Window, the list of patients in
that work list.

B. Failed Login

The ProviderLink system is a secure system and only allows users who provide the right
credentials to enter. In other words, you must provide a valid User ID and Password to successfully
log into ProviderLink. If you mistype either of these, you will not be allowed to enter, and the
system will display the failed login message, “You have entered an invalid password and/or User
ID, please try again.”

If you receive this message, check to make sure your User ID is spelled correctly. Then, re-enter
your Password, keeping in mind that the Password is case sensitive.

C. User Account Suspended

If you enter an incorrect password 5 times within 5 minutes, your Covisint account will be locked
due to an excessive number of invalid login attempts. As part of Covisint's comprehensive security
design, accounts are automatically locked when it appears someone is trying to guess the
password.

In order to unlock your account, simply use your challenge question and answer to reset your
password. This will automatically unlock your account.

1. From the https://healthcare.covisint.com page, click “Forgot your password?.”

a. The screen expands displaying a field to enter your User ID and then click Submit. The
Reset Password screen displays.

b. Enter the answer to your challenge question in the Challenge Answer field and click
Submit.
Note: You create your Challenge Question and Answer during the registration process.

c. Upon successful submission, the first half of the password displays on the screen, while
the second half is sent to email address you submitted during the registration process.

2. Alternatively, you may contact your facility Security Administrator to request that he/she
perform the password reset and unlock your account.

3. A Look At The ProviderLink Window

Once you successfully log into ProviderLink, you will see the patient list in the Main Window. You
can think of this as the main “control panel” used to navigate throughout ProviderLink. The list of
patients displayed on the Main Window can be considered your caseload, or the patients in your
“virtual in-basket” that you are currently working with.
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Lookup Setup Reports Print Refresh Help Logout Irtzke & NEXT | < Menu Bar

Facility: Medical_Center
View: Admissions
User: KM

Tasks:

Patients:
™

View —*
Information

Unread Messages: 12 Reviews Due: D

1 List Summary

Current View: Patient List v

b Total, 1 of 1 page( ] 4 Patient List 35003
-E_m Documents 3
Arrington, Reglna 91758 Mone Mone Mone 3 07/z2/2007

e Menu Bar — The Menu Bar at the top of the screen is the main navigation method to
different parts of the ProviderLink system.

e List Summary — This section gives an overview of the patients listed in the Main Window
and displays a total of the unread messages, patients, reviews due, and tasks in your work
list.

e View Information — This section displays information about the current view, including the
facility name, work list name, and the current user.

o Patient List — This is the list of patients currently assigned to your work list, usually sorted
by the patient's last name. You may re-sort the list by clicking on one of the column headers
(i.e., ID, Reference, etc.) along the green column header row. Each row represents
information about one of the patients in your work list, or a patient record.

Since ProviderLink is a web-based application, everywhere blue or red text appears is a hyperlink
or link. Each link is a shortcut, and clicking on a link will take you to another page or section within
ProviderLink. For example, clicking on one of the date links in the Documents column will take you
to that patient's documents.

A. Understanding The Patient List

The largest portion of the Main Window is the Patient List. The Patient List is divided into rows and
columns: the horizontal rows represent a patient record; and the vertical columns represent data
within each patient record.

Each of the fields in the Patient List is a link that you can use to navigate into different sections of
the patient record. The table below lists the columns in the Patient List, what each column
represents, and where the link leads when clicked:

Column Represents Link Destination
Message Icon [_] New message Create Message screen. Opens a
new message that relates to this
patient.
Patient Patient name, last name first View Patient Information screen
ID The Unique ID that helps your facility View Patient Information screen

identify the patient. Most commonly used to
display the medical record number.

Reference A note that helps identify something about  View Patient Information screen
the patient record. See the description in
the “Viewing Patient Information” section
below.

Tasks A reminder that some action needs to be Tasks for Patient screen
taken regarding the patient record.

Status Shows whether the patient has been View Patient Information screen
admitted, discharged, etc.
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Column Represents Link Destination

Auths

Shows the latest payor authorization Authorization for Patient screen
received for the patient.

Next Review Shows when the next payor review is due. Add/Edit Scheduled Task for

Patient screen

Unread Lists the unread messages received for the Unread Messages for Patient
patient.
Documents Lists the documents filed for the patient. Documents for Patient screen

As you become more familiar with ProviderLink's Main Window, you will learn shortcuts for
navigating to the sections you wish to use by using the links in the various columns.

B. Navigating The Main Window With The List Summary And Column Headers

You may customize the information displayed on the Main Window using the links in the List
Summary and the green column headers. By default, the Main Window will show you the list of
patients in the work list sorted in ascending order alphabetically by the patient's last name.

To Change The Content On The Main Window Using The List Summary And Column
Headers and Current View:

1. From the Main Window, click the Unread Messages link. The Main Window content

changes to display all of the unread messages with the most recent message at the top of
the list.

@ When you change the work list contents through a List Summary Link, the link turns
\

a.

b.

green so that you will know what information is being displayed.
You may change the list to display the oldest message first. Click the Date column
header link. The list will refresh with the oldest unread message appearing first.

You may group messages by Sender. Click the From column header link. The message
list will refresh with the Senders' names in ascending alphabetical order.

2. You may wish to see all of the tasks that are pending for your work list. In the List
Summary, click the Tasks link. The Main Window will refresh to display only the patients
that have tasks pending.

3. To view items that are overdue or pending, click the drop-down list to the right of Current
View and select from the following options:

a.

~® a0 o

h.

Patient List - displays the patient list for the current work list (default option).
Unread Messages List - displays a list of unread patient messages.

Task List - displays a list of patient tasks.

Reviews Due List - displays a list of patient reviews due.

Overdue Unread Messages - displays a list of the overdue unread messages.**

Message Needing a Reply - displays a list of received messages waiting on a reply that
were sent to that mailbox.**

Message Waiting on a Reply - displays a list of sent messages waiting on a reply that
were sent from that mailbox. **

Overdue Review Task - displays a list of the overdue review tasks.**
Overdue Reminder Task - displays a list of the overdue reminder tasks.**

** Option only displays in the drop-down list if it has been activated by your Facility
Administrator.
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4. To return the Main Window to its original state, displaying all of the patients, click Patients
in the List Summary.

4. Viewing Patient Information

Now that you are familiar with the Main Window and its various uses, you may drill down to a
specific patient record by accessing the View Patient Information screen. Each patient record can

be considered a patient “folder” that stores all of the patient's messages, documents, and other
vital information that relates to the patient.

To View Patient Information On The View Patient Information Screen:

1. From the Main Window, click a Patient Name link in the Patient column. The View Patient
Information screen appears.

Save Status Authorizations Documents Demographics Send Meszage Help Logout

—
Pm‘%l.rink Main Window = Patient, Test E

View Patient Information

Wiew Patient Information

Last Mame: * [Patigni | Unigue D [MR123123123 |
First Mame: * [Tt | Bithdste: e —
Micll Name: £ [

Suffis: |:| Column Reference: |Rm. G52 |

Message Reference: | —Select a Message Reference- |

Linked Work Lists

Al Svailable Work Lists: Add Wyiaork Lists Linked ta this Patient: *
ACH Pre Authorization ~ AnotherTestGroup ”~
capitalgroup = Kathy DME Test
CreditBalance Repornt Demo r
CSR One R v

Status_______________________________Jiinked Mailboxes

Current Status: Discharged Add

current Admizsion Date: Mone

Last Dizscharge Date: 0801 £2005 praviderlink - hain online  (F
Decessed Date; kane Providerlink Michael Hall - Michael Hall Faze Only @

2. The View Patient Information screen is divided into different sections. From this screen, you
can access anything relating to this patient.

a. The top section, also labeled “View Patient Information,” includes the patient's name,
date of birth, and Social Security Number.

b. The center section displays the work lists that are linked to this patient record. In other

words, it shows which department or which staff member is working with this patient
record.

c. The bottom left section, the Status section, shows a brief overview what has happened
with this patient record.

i. You can see when the patient was admitted or discharged.

ii. You can see when the last payor review was received and when the next review is
due.

iii. More importantly, you will see how many tasks and unread messages are pending
for this patient.

iv. You may also access the patient's History Iltems and Audit Trail.

10
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d. The bottom right section, the Linked Mailboxes section, lists the mailboxes that are
currently linked to this patient record. You may think of these linked mailboxes as
message “speed dials” that allow you to create messages to send to these mailboxes
quickly without having to search for them each time.

3. The menu bar has changed to include other areas that hold information about the patient
you are viewing. From the menu bar, click Documents. The list of Documents stored with
this patient record appears.

Add Document E-Farms Frint Help Logout
AP

ProviderLink  Main Window =» Patient, Test E = Dociments

—
Documents for Patient: Patient, TestE
______________Mame_________________d Ty o Facilty f ____User 9 Date |
Fax response RE: TEst 2 Faix providerlink Ron Prighe 06/18/2005 6:45 PM
Copy of NC Medicaid FL2 06M&/2005 0613 Phe™ E-Form FL2 providerlink Ron Priebe 06M852005 6:30 PM
Copy of ¥Wa LAl 05 82005 0815 Phe” E-Form LIAI providerlink Ran Priebe 06/1852005 6:30 PM
Copy of MC Medicaid FL2 08M 852005 08:13 PM E-Form FL2 providerlink Ron Prighe 06/18/2005 6:30 PM
Copy of NC Medicaid FL2 06M8/2005 0613 E-Form FL2 providerlink Ron Prighe 061812005 6:28 PM
ol L] 060 8/2005 06158 P E-Form LAl providerlink rpriehe 06/1852005 6:15 P
MC Medicsid FL2 D6/ 52005 06:13 P." E-Farm FL2 praviderlink rpriehe 061852005 6:13 PM
Test Referral Form Prirt providerlink Acimin ProviderLink 06/02/2005 3:33 PM
MNC Medicaid CWMMPA 02 0/2005 10:49 Ak E-Form ChbPA praviderlink Admin ProwiderLink 021072005 10:49 Ah
Fax response: RE: Fax providerlink Admin ProviderLink 021052005 §:53 &M
LA Hemi Wheelchsir 020972005 11:43 Akl E-Fartn LAY Hetmi YWheelchair praviderlink Acdmin ProwidetLink 02/0352005 11:49 Akl
Glucose Monitor 014 4£2005 0307 P« E-Form Glucose Monitor providerlink Acimin ProviderLink 011452005 3:07 PM
DMERC Cucygen 11/24/2004 10046 A E-Form DMERC464 2 providerlink Acimin ProvicerLink 11/24/2004 10:465 AM

j Notice the different types of documents listed in the Types column: Fax, E-Form, and
Print. These document types are described fully in the Name column.

4. Choose one of the documents that is an E-Form and click its name link in the Name column.
The E-Form appears. Take a look at the how the E-Form is set up.

A. Navigating The Breadcrumb Trail

The ProviderLink system does not use the Internet Explorer “Back” button to navigate back to other
pages. Instead, there is a breadcrumb trail, a navigation tool that allows you to see where the
current page is in relation to the path you took to get there. The term “breadcrumb trail” comes from
the story of Hansel and Gretel, who left a trail of breadcrumbs as they walked through the forest so
they could trace their way back home. In this same way, ProviderLink's breadcrumb trail acts as a
“You Are Here” sign and shows you the path to get back to a previous screen. ProviderLink's
breadcrumb trail is the set of links located near the top of the screen just below the menu bar

You may trace your path back one-step at a time, or you may skip steps and jump back to a
previous location earlier in the breadcrumb trail. For example, all breadcrumb trails will begin from
the Main Window and clicking the Main Window link will return you to the Main Window. Clicking
the Patient Name link in the breadcrumb trail will return you to the View Patient Information screen

To Use The Breadcrumb Trail To Navigate Within ProviderLink:

1. From an open E-Form (or any other section of a patient record), click the Documents link to
return to the list of documents.

Save Save and Send Save and Cloze Save Copy Check. PDF Format Signatures Help Logout

‘--"\, ™
Pmﬂr':lil:jnk Main Window = Patient, Test E = Documents = NC Medicaid FL2

2. In the breadcrumb trail, click the Patient's Name link. You will return to the View Patient
Information screen.

11
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3. Click the Main Window link in the breadcrumb trail. You will return to the Main Window.
Notice the breadcrumb trail is a one-way path back to previous screens. To re-enter the
View Patient Information screen, click the patient's name link.

The breadcrumb trail is a powerful tool for navigating back to the screens you have already visited.
After you become familiar with how the breadcrumb trail works, you will learn to use it to navigate
more quickly throughout the ProviderLink system.

B. Viewing A Patient's History Items And Audit Trail

One of the foremost benefits in using ProviderLink for communication is that the system tracks
every message sent or received regarding the patient in that patient's History Items. The patient's
History Items screen will show you who the message is from, whom the message is addressed to,
whether or not a message was sent successfully, when the message was sent, the message
subject, and the number of documents attached to the message. If the recipient is also online with
ProviderLink, you will see whether or not the recipient has read the message, when the message
was read, and whether or not the recipient sent a reply. Clicking on the message subject link will
open the message for you.

If you need more detailed information about the history of the patient's record, you may view the
patient's Audit Trail. The Audit Trail keeps an accurate record of not only a running history of the
messages, but also the patient's documents, tasks, and the work lists linked to the patient record.

To View A Patient's History Items And Audit Trail:

1. From the View Patient Information screen's Status section, click History Items. The
Message History for Patient: screen appears.

audit Trail Print Help Logout

Pm"u'r‘i'derl.inkm Main Window=s Arrington, Regina=s Histo
|: r - _Ir ] _|I' * r}'l

Message History for Patient: Arrington, Regina

15 Total, 1 of 1 pageis) JLU0A)

Date Sent“| User> | To> | From* | Subject> | [Status*| Read | Reply |

03/13/2008 Kate Critical Care - Medical_Center Mo Subject 1 Failed Unread

1:00 amM Miller Main 03/13/2008
1:00 AaM

03/13/2008 Kate Medical_Center Medical_Center Fax Failed 0 Sent Unread

1:00 &M Miller - Main Warning:

Critical Care

2. The Message History screen shows a complete history of any messages sent or received
regarding this patient.

3. By default, the message history is sorted by date and time with the most recent message at
the top of the list. Like other lists you have seen, you may sort this list by clicking on the
column header links. Click the From column header to sort the list by message sender.

4. To return the list to its original state, sorted by date and time, click the History link in the
breadcrumb trail.

5. To view a more detailed history of the patient record, click Audit Trail on the menu bar

6. The Audit Trail tracks the activities of the users who have been working with this patient
record. You may use the column header links to sort the list by Date, User Name, Patient,
or Audit Entry in order to find an entry more quickly.

12
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Print Help Logout

préviderLink . Main Window=> G. George=p History=y Audit Trail
rovi rrl gl oW A FFOL, eorge fSrOf]-" it 1rat

iew Audit Trail for Patient: Garrott, George

0 Total, 1 of 2 page(s) )50 12° 0
Audit Entry &

01/25/2007 10:35 Kate Miller Garrott Patient Created, Patient Mame: George Garrott DOB: 19231-10-01 23:00:00.0 Member Reference:

f M George

01/25/2007 10:35 Kate Miller Garrott , Wwark list Updated. Added: {Admissions} Revised list: {Admissions}

George

7. Click Main Window in the breadcrumb trail to return to the Main Window.

assured an accurate record history from the time the patient record was created to the

\@ Neither the Message History nor the Audit Trail is editable, so you will always be
p=al i
{ present time.

5. Changing Your Work List View

ProviderLink allows you to view the work lists for other users within your facility. This enables you
to check the status of a patient or access a patient's documents without having to wait for the user
to send it to you. Also, if you are away from your workstation, another user may access your
patients' information. You may also view patients in all work lists to get a summary of everyone in
your system.

To Change Your Work List View: praviderLink ™
1. From the Main Window, click the View: link in the View ( &
Information section in the upper right corner. The Choose
Work List View screen appears.
2. From the View drop-down list, choose the work list you | |, o o
wish to view. Click the Submit button. The chosen work view: |[AB Bre e ~
list appears. [Bubmit

6. Working With Patient Records

ProviderLink stores all messages and documents with their respective patient records. Before you
can store a document or send a message, you will need to access an existing patient record or
create a new one.

Before creating a new patient record, you will want to prevent duplicating patient records by
searching for existing patient records first.

To Search For A Patient Record:

1. From the ProviderLink Main Window menu bar, click Lookup = Patient. The Patient Lookup
screen appears.

13
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Search Mew Help Logout
Pro"n'ri'derl.inkm Main Window=p Patient Search
(L & ) )
Patient Lookup
Unique ID: | |
Last Mame: | |
First Name:| |
SSN: | 111223333 or 111-22-3333)
Birthdate: | |/ |/ | (mmddddyyyy)

2. Enter the criteria for which you wish to search, and click the Search button. The system will
search your existing patient database for records that match your criteria.

For the best search results, you may want to only enter the first few letters of the
@\ patient's name, or use the Unique ID. This way, you will still be able to find the patient
A | record in case the patient's name is spelled differently in the record.

3. If the system finds any patient records matching your criteria, you will see a list of matching
records at the bottom of the Patient Lookup screen.

4. If the system found the patient record you were searching for, click one of the blue links to
access the patient's View Patient Information screen.

Search M e Help Logout

Mu W j atremnt SE.HCJ'T
ProviderLink T [Ty —> F 1
W

Patient Lookup
Search For a Patient
Unique IO |

|
Last Mame: |rn |

First Name:l |

SEN: | ] 111223333 or 111-22-3333)

Birthdate: | [/[ |/ | (mmddsyyyy)
2 Tatal, 1 of 1 page(s) W LA LE LRI

Middle Name
Tark Macy - 06/12/1989
Julie MeCay = 12/11/1948 MR1234567

5. If the system does not find the record you were searching for, the following message

displays: “There were no patients found matching that criteria.” You may change your
search criteria and try the search again.

6. If you are unable to find the patient record, a record may not yet exist for that patient. To

create a new patient record, click New from the Search Results menu bar to display the Add
Patient screen.

A. Creating A New Patient Record

If no patient record exists, you will need to create one before creating any documents or sending
any messages for that patient.

To Create A New Patient Record:
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1. From the ProviderLink Main Window menu bar, click New = Patient. The Add Patient
screen appears.

Save Help Logout

PrviderLink . Main Window=> Add Pati
o ‘rr AT oW ol Fatient

Add Patient

Last Marme: * || | Unique ID: | |

First Marme: *| | Birthdate: * | |;| |;| | (rarnddddyyyy)
Middle Name:| | SSN: | | ; | | . | |

Suffix: | | Colurnn Reference: |

Message I:'~'31:'E”"3|"'3'E“| -5Select a Message Reference-- w |

2. Notice the required fields as noted with red asterisks (*). You must complete these three
fields in order to successfully save your new patient record. Enter data in the required
fields, at a minimum.

Although the other fields are optional, it is generally a good idea to enter as much
information as you have for each patient record. Later, when you create E-Forms for this

e \ patient, the system can use this data to populate the fields on the E-Form.

3. The optional Unique ID field is generally used to record the patient's medical record
number or other identifier that uniquely relates to that patient.

4. The Column Reference is also optional and is generally used to note something about that
patient record. For example, you may use this field to remind yourself and your coworkers
what is pending (e.g., “Placement pending”) or to note the patient's room number.

5. It may be necessary to link your work list to this patient record so that, when you view your
work list, this patient record will be included in the list. View the Linked Work Lists section in
the center of the screen to ensure the desired work list appears in the right-most list box
and will be linked.

Linked Work Lists
All Available Work Lists: Al Wark Lists Linked to this Patient: *

Chd 35 GYM ~ FS Dianna P »
Chd 45 =

Chd BN Peds

Ch ES v v

6. When you are finished entering the patient's basic information and choosing the work lists
to link, click the Save button to save the record. The patient record is saved and the screen
refreshes to show you the saved patient record with more options.

7. Logging Out of ProviderLink

When you are finished working in ProviderLink, you should end your ProviderLink session. Logging
out is important, especially if you share a computer with other users. This creates an accurate
message history and audit trail by ensuring that the user ID logged in is actually the user who is
working in the system.

To Log Out Of ProviderLink:
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1. From virtually any view, click Logout on the menu bar.

MHew Lookup Setup Repaorts Print Refrezh Help Logout

2. The system will log you out, show you a log out confirmation screen, and after a few
seconds, returns you to the ProviderLink Login screen.

A. Automatic Logout

ProviderLink also has an automatic logout feature. For security reasons, the system will log you out
after a designated period of inactivity. In other words, if the ProviderLink system determines that
you have not changed or refreshed a screen within this timeframe, the system will log you out and
return to the main ProviderLink Login screen. Log into ProviderLink again.

16
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Section 2 Summary

After this hands on tour through the ProviderLink system, you should now know:

what to do if you are unable to log into ProviderLink
what appears on the Main Window and how the Patient List is organized

And how to:

17

access the ProviderLink system

log into ProviderLink

view Patient information

use the breadcrumb trail to navigate within ProviderLink
view a patient's History Items and Audit Trail

change your Work List view

look up and create patient records

log out of ProviderLink



Using ProviderLink in Your Daily Work

Section lll - Using ProviderLink In Your Dail

1. Utilization Review

ProviderLink brings much needed structure and accountability to the communications required for
utilization review. Both hospital and payor request messages are automatically routed to the
associated patient record. All information requests are time and date stamped and kept in an audit
trail that both the sender and recipient (if online) can see. Sending information through
ProviderLink is like sending certified mail that cannot be lost or forgotten. ProviderLink affords the
case manager a single screen for viewing an assigned caseload.

A. Linking Payor Contacts To A Patient Record

ProviderLink gives you the ability to link frequently used contacts to individual patient records.
These “Quick Links” will enable to you quickly send messages, including reviews and authorization
requests, to the patient's insurance payors without having to search for the respective payor
contacts each time.

Once you have linked the payor mailbox to the patient record, you may edit the link to add the
patient's subscriber or account number. Then, whenever you send a message to the payor on
behalf of that patient, the patient's subscriber number will appear with the message to assist the
payor in processing the request.

To Link A Contact To The Patient Record:

1. From the View Patient Information screen in the lower right section labeled “Linked
Mailboxes,” click the Add button. The Facility Search screen appears.

Search Mew Contact Close Help
Search
| Facility Search |

Search For a Facility
Facility Type: Select a Facility Type w
Facility Mame: ||

Unique ID;
Fax Murnber:
Last Name:
First Mame:

Main Phone
Murmber:

City:
State/Province: | Mo State Selected w | Zip:
County: Select a State First b

Show: M online M Fax-only [ system Fax-only

2. Click the Facility Type drop-down list and select “Payor/Reviewer.”

3. Enter your search criteria in the appropriate fields. At a minimum, enter the first few letters
of the payor's name in the Facility Name field. After entering your search criteria, click the
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Submit button. The system will search for payors matching your criteria and display the
Search Results screen.

Note: If the system does not find the payor you were searching for, the following message
displays: “There were no facilities found matching that criteria.” You may change your search
criteria and try the search again.

4. View the mailboxes or individual contacts to choose the mailbox you want to use and then
check the box in the first column.

Save Mew Contact Close Help
Search Results

2 Total, 1 of 1 page(s) Q4L
|| _Mailbox Name | Facility Name ~_| First Name + | Last Name | Unigue ID | Fax Number| _City | County |State| Zip |
[] Inpatient Reviews BCBENC Inpatient Chape Hill NC 27702
Revigws
[] claims Attachments BCBSHC Clairns Chape Hill NC 27702
Atkachments
[ 5ave | [ Selectal | [ Unselect &l |

5. If needed, click the Facility name link to view the contact information, for that facility. The
Facility Information screen appears. Click Close to return to the Search Results screen.

Close Help
Facility Information
Facility Mare: BCBSNC
Main Phone Mumber: 919-F55-7884
Facility Type: Payar/Reviewer
Aooess) online
City: Chape Hill
State: Mz
Zip: 27702
County; Mo Countv Selected

6. On the Search Results screen, once you have verified the mailbox, click Save on the menu
bar. The payor contact will be linked to the patient and the system will return you to the
View Patient Information screen.

7. Through ProviderLink, you will send messages the same way using the same interface
whether the payor facility is online with ProviderLink or fax only.

8. You are now ready to add the patient's payor subscriber or account number to the link. On
the View Patient Information screen, click the Edit Link icon to the right of the payor link.
The Edit Link screen appears.
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Save Help | Logout

H.l ™
Pm‘%l.rink Main Window = McCoy, Julie = Edit Link

Edit Link for Patient: McCoy, Julie

Facility Mame: BCBSNC-Cammercial
Mailbo: Mame: |Inpatient Fenviews
PayorReviewer Type: | F"rimar}f £Y3 | |:|I_Inlink Payor

Cther Reference: |95}‘554-E2‘| b

Mon-Yiewwable Comments:

9. Enter the reference information in the Other Reference field and click the Save button. You

AN

will return to the View Patient Information screen.

Any information that is entered in the "Other Reference" field will be sent with all
messages to the “linked” payor regarding this patient. Entering a reference into this field
will help the payor who receives a message from your hospital to identify the patient

record.

B. Changing The Patient's Admission Date

You will want to notify the patient's insurance payor of any change in the patient's status (e.g.,
admission, discharge, etc.). ProviderLink simplifies this process with the “Current Admission” link

from the View Patient Information screen and the "Status" option on the menu bar

To Change The Patient's Admission Date:
1. From the ProviderLink Main Window menu bar, click Status = Admitted. The Patient

2.

Admitted screen appears.

Save Help Logout

1 M. W 1 MeCull Emil —> A
ProviderLink < L) —> LIITerT,
amn oW (s id dmitted

Patient Admitted: McCullen, Emily

Unique ID: * [MR1234567

Status Change:

Date of above Status Change: *I:ID fmmAddAy ey

If necessary, enter the patient's unique ID in the Unique ID field.

3. Enter the admission date in the Date of above Status Change field by entering the date or

choosing the date using the calendar pop-up tool.
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4. You may use the Viewable Comments field to note the conditions or circumstances under
which the patient was admitted.

5. Click the Save button to change the patient's status and send the message(s) to the
payor(s). The system displays the View Patient Information screen, changes the patient's
Status field to “Admitted,” and updates the Current Admission Date.

\@ You may also change the patient's status to “Admitted” by clicking Status > Admitted
\ from the View Patient Information screen menu bar.

A

C. Creating Reminder Tasks

A task is a work item that needs to be performed by a certain due date. ProviderLink helps you
remember to accomplish these work items through the Tasks function on each patient record.

There are two types of tasks you can assign through the patient's Task function: reminder tasks
and review tasks. Insurance payors generally require clinical reviews to determine whether the
services you are requesting are medically necessary. Online payors can assign review tasks when
they send their authorizations, and users can set review tasks for payors that are fax-only contacts.
To help remember other work items that are not reviews, you can assign reminder tasks. For
example, when a patient is admitted, you may create a task to remind you to send clinical
information to the insurance payor. You may assign review or reminder tasks to your own work list
or to another linked facility, as necessary.

To Create A Reminder Task:

1. From the View Patient Information screen Status section, click Tasks. The Tasks For
Patient screen appears.

2. From the menu bar, click New to view the Add/Edit Scheduled Task for Patient screen.

Save Print Help Logout

—
Pm‘\'.r"lder’.'.ink Main Window= Patient Search = McCoy, Julie = Tasks= Add Task

Add/Edit Scheduled Task for Patient: McCoy, Julie

Task Type: Reminder v

Description: *
Send a Message To:
Due Date: * ) mméettvyy) - Select a Faciliy — v

Non-Viewable Commenis:

* Required field

Note the required fields as indicated by the red asterisks. Enter the task description in the
Description field.

3. Each tasks needs a due date. You may either enter the date in the Due Date field, or use
the pop-up calendar tool.

4. Enter your notes in the Non-Viewable Comments field, if desired.

5. When you are finished setting up the task, click the Save button. This saves the task and
returns you to the Add/Edit Scheduled Task for Patient screen.
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D. Adding Documents To Patient Records

ProviderLink enables you to store patient-related documents with each patient record. Any
document that is sent to you online or faxed into the system can be added to a patient's record.
You can also use the online E-Forms function in ProviderLink to create documents. In addition,
virtually any hard copy, paper document, or any report you can print to a local printer can be added
to a ProviderLink patient record and be sent in a message to another facility.

To Add A Hard Copy Document To A Patient Record (Fax Attach):

1. From the View Patient Information screen's menu bar, click Documents to view the
Documents For Patient screen.

2. On the menu bar, click Add Document > Add By Fax. The Add A Fax screen appears.
3. Enter a document name that fits the type of document you are adding.

Prirt Help Logout

-_"*:, ™
Pm‘u’ri'de‘rl.rink Main Window=» McCoy, Julie=» Documents=» Add Fax

Patient: McCoy, Julie

Documert Mame * Health & Physical

" Required field

4. Click Print on the menu bar or the Print button. The system will generate a bar-coded
cover page.

Print Cloze

S

Fax Cover Page

Fax to: 1-919-852-1822

All pages (up to 40 pages) following this cover page will become a document on patient
McCoy, Julie

Thiz document will be named:
Health & Physical

*XYEAHT*

5. Click Print on the menu bar to display the print options and print the cover page on your
printer.

6. After the cover page prints, click Close on the menu bar to close the cover page and return
to the Documents for Patient screen.

7. Once the cover page prints, place it on top of the hard copy documents and fax the
package to the number indicated on the cover page. After the fax sends successfully, the
document will be listed on the Documents For Patient screen (this screen may need to be
refreshed).
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- ™ . . .
ProviderLink  Main Window=y McCoy, Julie =p Documents

Documents for Patient: McCoy, Julie

| _Name ____ Typed Facility | User < Modified Date Create Date

Il D a0 m Health & Physical Fax Medical_Center Kate Miller 07/16/2007 8127 AM 07/16/2007 8127 AM

[ Move ][ Delste ][ Select Al ][ Unselect Al ]

23

8. You may click the document Name link to view the document you added.
To Add A Document From Another System To A Patient Record (Print Attach):

1.

From the View Patient Information screen's menu bar, click Documents to view the
Documents For Patient screen.

Note: A new version of the print application is available that allows you to print attach while
not logged in to ProviderLink. Contact ProviderLink Customer Support for instructions on
upgrading to the newest version.

On the menu bar, click Add Document > Add By Print Job. The Add A Print Job window
appears.

Enter a document name that fits the type of document you are adding.

Click the Print button. The Print Now screen appears and the system is ready to receive
the document from another application.

]

https:/itraining. providerlink.com - ProviderLink - Print Now - Mozilla Firefox

Cloge

Print Now

Open the application from which you want to print and select "print" from the application's file dropdown menu
Print to the ProviderLink Virtual Printer.

his may take a few seconds.

DO NOT PRESS THE "CLOSE" BUTTOMN QM THIS WINDGYY UNTIL YOU RECEIVE A MESSAGE SAYING
HAT THE PRINT JOB HAS BEEN SUCCESSFULLY SENT.

Leaving the ProviderLink windows open, open the clinical system that contains the report
and prepare to print it.

Change the printer options to print the report using ProviderLink Virtual Printer. The
document will spool to the printer and the ProviderLink Internet Gateway dialog box

appears.
>

et

Print Job: Training Manual - Hospitals. odt

Intermet Destination:  https:/ftraining. providerlink., comyfproviderlinkprintCatcher

The send completed successfully.

[IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII]

After the status bar fills and the window displays the message “The send completed
successfully,” click the Close button.

Minimize or close the clinical system and return to ProviderLink.

Close the Print Now window. The Documents For Patient Screen will refresh and you
should see the document you print attached added the list.
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Note: Documents added to the patient record using the Add By Print Job feature can only be
attached to a message and faxed if the document is saved as a PDF file. However, documents
saved as Word, text, PDF files, etc. using the Add By Print Job feature can all be sent online
(electronically) using ProviderLink.

Documents for Patient: McCoy, Julie

Facility | User ¢ Modified Date Create Date

D D DEE.’L @ Health & Physical Fax Medical_Center Kate Miller 07/16/2007 8:27 &AM 07/16/2007 8:27 AM
D D DEE.'L @ Benefits Surnmary Print Medical_Centar Arny Parriss 05/22/2007 2:05 PM 05/22/2007 2:05 PM

[ Move | [ Delete | [ Select &l | [ Unselect &1

To Add An Electronic Form (E-Form) To A Patient Record:

1. From the View Patient Information screen's menu bar, click Documents to view the
Documents For Patient screen.

2. On the menu bar, click E-Forms to view the available forms.
3. Select the appropriate Form Name. The system will display the form you selected.

4. Complete the fields on the E-Form, paying particular attention to the required fields as
indicated by the red asterisks.

5. After completing the form, click Save on the menu bar.
Note: Remember to Save often.

6. To have the system check to see if the form's required fields have been completed
correctly, click Check on the menu bar After checking the form, the system will display red
text below the fields to show any errors. Fix the errors and check the form again.

7. Once you are confident there are no errors on the form, click Save on the menu bar.
8. To close the form, click Save and Close on the menu bar.

E. Sending Reviews To Payors

ProviderLink makes the process of sending clinical reviews to insurance payors easier and more
efficient. When using tasks, as described above, ProviderLink will remind you when reviews are
due and you can send a message containing the review from the task itself.

To Send A Review To A Payor From The Task:

1. If you are using tasks to remind you when a review is due (see “Creating Reminder Tasks”),
click Tasks from the View Patient Information screen Status section. The Tasks For Patient
screen appears with the listed tasks.

2. Find the task for which you are sending the review and click the task's Description link.
The Add/Edit Scheduled Task for Patient screen appears.

3. Choose the facility to which you want to send the review from the Send A Message To
drop-down list and click the Send Message icon (a small envelope). The Create Message
screen appears with the message already addressed to the chosen facility.

—
Pm@nk Main Window = McCoy, Julie=» Tasks=> Edit Task = Create Message
Patient: McCoy, Julie DOB: 05/051535
—Select Recipients — A
To Recipients: ' BCBSMC - Inpatient - Online S [“ILink 21 Recipients
v
From Mailbox: Main v

4. Select the necessary clinical documents from the Available Documents drop-down list or
copy and paste the clinical data into the Message field.
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Note: When including an attachment to a message to a fax-only facility, only documents
saved as PDF or TIF files (i.e., faxes) can be sent. If other file types are attached (e.g.,
Word doc, text file, Excel spreadsheet, etc.), a warning will display stating that this file type
cannot be sent to a fax-only facility.

5. Fill in a message Subject. Be sure the message includes the patient reference number or
other insurance information to identify the patient.

If you want to track whether or not you have received a response, click the Request a
Reply check box.

7. You can be reminded that you are awaiting a reply from the payor by selecting the Create a
Reminder Task check box.

o

E Include Fax-Back Cover Page
[For Fax Only Recipient=]

Create a Reminder Task

©

When you are satisfied with your message, click Send. The system will send the message
and return you to the Add/Edit Scheduled Task screen.

Regardless of whether the message recipient is online or fax-only, you will send the
message the same way. ProviderLink will determine the facility type and send the
message accordingly.
If the recipient is online, the receiving facility will receive your review as an unread
: message in their work list. They will reply to you online as well.

I@ If the facility is fax-only, they will receive your review over their fax, complete with a bar-
coded, ProviderLink fax-back cover page. When the facility replies, they will use the fax-
back cover page.

With either type of reply, you will receive the response as an unread message attached
to the patient record.

9. Now that you have completed the task, from the menu bar click Complete > Without
Notes. The system will return you to the Tasks for Patient screen.
To Send A Review To A Payor From The View Patient Information Screen:
1. From the View Patient Information screen Linked Mailboxes section, click the Payor Name
link. The Create Message screen appears with the message already addressed to the
chosen facility.

2. Follow Steps 4 - 8 above to send the review to the payor. When finished, you will return to
the View Patient Information screen.

F. Handling Payor Responses

Insurance payors will send authorizations to you through ProviderLink. Whether they send the
message through an online reply or with a fax-back cover page, the system will route the message
to the patient record and it will appear as an unread message.

M ex
Reference 5| T askg
Review

Moy, Julie hiR234:5369 Admitted 002652003 095252003 Q972352005

If the payor is online, they should post the authorization to the patient record through ProviderLink's
Authorization feature. When the authorization is posted, the patient's authorization date is updated
on the Main Window and on the View Patient Information screen. The payor can also assign you a
task for when the next review is due. For authorizations received from fax-only payors, you can
document the authorization and set up the next review task.
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To Read Messages:

1. From the View Patient Information screen Status section, click the Unread Messages link.
The Unread Messages For Patient screen appears with the oldest message appearing at
the top of the list.

Pro‘a'.r'i'derLinkm Main Window = McCoy, Julie = Unread
il i 0 L0 ;

Unread Messages for Patient: McCoy, Julie

-m__“-

09/26/2005 11:11 AWM BCBSNC - Inpatient Iain RE:Clinical Rewview:
0902652005 11:12 AWM BCBSNC - Inpatient hain Auth Posted - 876543 1]

2. Click the Subject link for the message you wish to read. The Message screen appears.

3. Each message shows you the related patient information, who the message sender and
recipient are, when and how the message was sent, the message subject and text, and any
document attachments. Also, you can see if the sender requested a reply.

Reply  Foward  Mak Unread  Contact  Auth Fint  Help  Logout

Ay
ProviderLink Main Window=r McCoy, Julie = Unread = Read Message
—

Patient: McCoy, Julie
DOB: 051051935

To: Failty: AMSGeneralHospital From Facility: BCBSHC
Mailboe Wams: Main Mailbox: Mailbox Name: Inpatient
Cther Reference: User: Admin ProviderLink
Connection: Online Unicyue 10z 9376543210M
Reference:
09/26/2005 11:11 AM Ho reply requested by sender
Message Status: Sent
Attached Documents:
[
Subject: RE:Clinical Review

Message:
See authorization posted. Thanks !

--------You are replying to the following message—--—---
Subject: Clinical Review

Zeme: 08/26/2005 11:05 AM

Text:

4. If you wish to reply to the message, click Reply on the menu bar A Create Message screen
will appear with the To Recipient and Subject fields already populated for you. Fill in the
rest of the fields accordingly and send the reply.

5. If you wish to forward the message to another user or facility, click Forward on the menu
bar A Create Message screen will appear with the Subject and Message fields already
populated for you. Fill in the rest of the fields accordingly and forward the message.

6. If you wish to mark the message unread, click Mark Unread on the menu bar You will
return to the Unread Messages For Patient screen.

7. Once you have finished reading the message, you may return to the Unread Messages For
Patient screen by clicking the Unread link in the breadcrumb trail.

To Post Authorizations Received From Fax-Only Payors:

1. From the View Patient Information screen Status section, click the Current Authorization
link, or click Authorizations from the menu bar The Authorizations For Patient screen
appears.

\@ In order to add an authorization for a fax-only facility that facility MUST be linked to the
% patient record first. See “Linking Payor Contacts To A Patient Record.”

A

2. From the menu bar, click Add Authorization. The Add/Edit Authorization screen appears.
3. If necessary, select the correct insurance payor from the Issuer drop-down list.
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—
P‘:lo‘v'.lc'!%ink Main Window = McCoy. Julie = Authorizations=» Add Auth

AddiEdit Authorization McCoy, Julie

Crested:

how 1]

Creator: | |

; orization Information

Available

5 o |—Se|edaD0cument— V|
QCUments:

E

Documents

Issuer | Ametican Healthcare - Inpatient Reviews & | To Attach:

b

Recipient | AMSGeneralHaospital - Main |

Approved (¥

Approval:

Avtharization: ||
.

Description: |

Current 09/13/2005 E tramicdtiy
Admigzion

Diate:

Fill in the authorization number in the required Authorization field.

Enter the date range the authorization covers in the From Date and To Date fields.

You may enter comments about what the authorization covers in the Viewable Comments
or Non-Viewable Comments fields, if desired.

In the Next Review section, use the Review Date field to set up a task for the date the next

review is due.

Once you have documented the authorization, click Save to save the authorization and
return to the Authorizations For Patient screen.

Authorizations for Patient: McCoy, Julie

[ Created o ___lssuer ___“] __Recipient | Authorization | Description|Notes| | Creator___4

09/26/2005 1:19PM Ametican Healthcare AMSGeneralHospital 123 o

0 admin@@AsMSGeneraHozpital

G. Changing The Patient's Discharge Date

As with the patient's admission date, you will want to update the patient record and inform the
patient's insurance payor(s) of the patient's discharge. You can do this by changing the patient's
status on the View Patient Information screen.

To Change The Patient's Discharge Date:
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1. From the View Patient

Information
screen Status section, click the Last
Discharge Date link. The Patient
Discharged screen appears.

If necessary, enter the patient's unique
ID in the required Unique ID field.

Enter the admission date in the Date
of above Status Change field by
entering the date or choosing the date
using the calendar pop-up tool.

You may use the Viewable
Comments field to note the conditions
or circumstances under which the
patient was admitted.

PrviderLink  Main Window=> McCoy, Julie=d Discharged
row| 'r._ gl HIOOW C -O_V_. e IS¢ T;?J"_l]ef

Patient Discharged: McCoy, Julie
Unique I1D: * [MFi1234567 |

Date of above Status Change: *I:ID fmmAddAy ey

Status Change:
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5. Click the Save button to change the patient's status and send the message(s) to the
payor(s). The system displays the View Patient Information screen, changes the patient's
Status field to “Admitted,” and updates the Current Admission Date.

H. Managing Your Work Lists

Patient records are often moved through a workflow. Tasks and patients can be easily moved from
one work list to another and so on to complete a workflow. When a patient is moved from one work
list to another, all of the properties of that patient such as tasks, overdue items, etc., move to the
new work list. So if a patient is moved, for example, from one unit to another in a hospital setting,
all of that patient's open tasks and overdue items are automatically added to the new case
manager's work lists. The new case manager can also see all related documents, forms,
communication histories, authorizations, open communication requests, etc.

After your portion of the patient's workflow is completed, you may remove a patient from a work list.
The system will display a message if the patient record has any unread messages, incomplete
tasks, or overdue items. If yours is the last work list linked to the patient, you will need to process
all outstanding items (i.e., all unread messages and undone tasks) before removing the patient
from your work list.

To Link Another Work List To The Patient Record:
1. From the View Patient Information screen, locate the Linked Work Lists section in the
center of the screen.

2. Select the work list you wish to add from the All Available Work Lists list box and click the
Add button. The chosen work list will be added to the Work Lists Linked to this Patient
list box.

3. On the menu bar, click Save. The system saves patient record and adds it to the linked
work list(s).
To Remove A Work List From The Patient Record:

1. From the View Patient Information screen, locate the Linked Work Lists section in the
center of the screen.

2. Select the work list you wish to remove from the Work Lists Linked to this Patient list box
and click the Remove button. The chosen work list will be removed from the Work Lists
Linked to this Patient list box.

Linked Work Lists
Al Aveailable York Lists: Add Wiark Lists Linked to this Patiert: *

Admissions » Intake ~
Discharge Flanning IR Angie Able

Cutpatient Services

IR Clara Capable w w

3. On the menu bar, click Save. The system will check to see if there are any unread
messages or incomplete tasks and, if there are, it will display an “Open Items” message.
Review the message and click the Remove button.

4. If there are no other work lists linked to the patient record, the system will not allow you to
remove the work lists and will display a message. Click the Continue button to return to the
patient record and close the outstanding items.

5. Once the patient is removed from the work list, the updated work list appears with the
remaining patient records.
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2. Discharge Planning

Discharge planners deal with some of the most time critical communications in the hospital. They
often need to get a payor authorization prior to discharging. Medicaid in most states requires the
completion of a manual hard copy form and that referrals be sent to all providers within a certain
mile radius. Discharge planners must keep up with changing discharge dates and skilled nursing
bed availability. They are often manually sending out communication requests trying to answer
qguestions like, "Who has an available male bed in this geography, a secure ward, provides dialysis
transportation, and takes MARSA patients?” Referral packages have to be compiled based on
information from several different systems and paper-based charts. Broadcasting referral packages
to numerous facilities is costly and time consuming. Tracking the referral status, which facilities
have responded and which ones need additional information, can be overwhelming.

With ProviderLink, clinical information can be imaged right from a discharge planner's desk from
many clinical systems using our virtual printer. Paper hard copy information can be imaged using
any fax machine as a scanner using our fax imaging process. All images from any source can be
attached to a single referral and then sent online as a paperless package to a specific provider or
broadcasted to customer-defined distribution lists. Online providers will receive the referral
package electronically and offline providers will receive the package on their fax machines. Online
providers can reply instantly to accept the patient or to request additional information. Offline
providers can respond using the supplied fax-back cover page, which will route their reply directly
to the discharge planner's screen and open request. Either way, this is a simple and paperless
process. At a glance, discharge planners can see who has responded and who has not. Online or
fax-only providers usually set up their alerts to page them whenever a new referral arrives through
ProviderLink, eliminating the need for a phone call and speeding up response times. Several states
now offer their Medicaid authorization forms and process online through ProviderLink. The form
can be completed and sent online with authorizations appearing automatically back on the
discharge planner's screen organized by patient. Authorizations can then be forwarded to others as
needed. Once imaged, referral information can be sent to any online or offline facility instantly.

A. Adding Documents To Patient Records

Often times you will need to send the skilled facilities or payors additional clinical information to get
placement offers or authorizations for services. ProviderLink enables you to store patient-related
documents with each patient record. Any document that is sent to you online or faxed into the
system can be added to a patient's record. You can also use the online E-Forms function in
ProviderLink to create documents or you can copy information from clinical systems and paste it
into a blank notes E-Form. In addition, virtually any hard copy, paper document or any report you
can print to a local printer can be added to a ProviderLink patient record and be sent in a message
to another facility.

To Add A Hard Copy Document To A Patient Record (Fax Attach):

1. From the View Patient Information screen's menu bar, click Documents to view the
Documents For Patient screen.

2. On the menu bar, click Add Document - Add By Fax. The Add A Fax screen appears.

3. Enter a document name that fits the type of document you are adding (e.g., Health &
Physical).
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Print Help Logout

PréviderLink . Main Window=> McCoy. Julie=> D = Add F.
o 'f__ =il T [ -ﬂ'}",— TiFre OCHITTents I Fax

Patient: McCoy, Julie

Document Mame *

Health & Physical |

* Required field

4. Click Print on the menu bar or the Print button. The system will generate a bar-coded

cover page.

5. Click Print on the menu bar |l te=

to display the print options
and print the cover page on
your printer.

Fax Cover Page

6. After the cover page prints,
click Close on the menu bar
to close the cover page and
return to the Documents for
Patient screen.

Fax to: 1-919-852-1822

McCoy, Julie

All pages (up to 40 pages) following this cover page will become a docurment on patient

i

7. Once the cover page prints,

This dacument will be named

Health & Physical

place it on top of the hard
copy documents and fax the

*XYEAHT*

package to the number

indicated on the cover page. After the fax sends successfully, the document will be listed on
the Documents For Patient screen (this screen may need to be refreshed).

DrdviderLink  Main Window=> McCoy, Julie =5 D
('OV 'r._ gl TIoW C O‘f, ulie OCHIments

Documents for Patient: McCoy, Julie

| _Name ____ Typed Facility | User < Modified Date Create Date

Health & Physical Fax Medical_Center

OBGEHET

[ Move ][ Delste ][ Select Al ][ Unselect Al ]

Kate Miller 07/16/2007 §:27 AM 07/16/2007 §:27 AM

8. You may click the document Name link to view the document you added.

To Add A Document From Another System To A Patient Record (Print Attach):
1. From the View Patient Information screen's menu bar, click Documents to view the

Documents For Patient screen.

Note: A new version of the print application is available that allows you to print attach while
not logged in to ProviderLink. Contact ProviderLink Customer Support for instructions on
upgrading to the newest version.

On the menu bar, click Add Document > Add By Print Job. The Add A Print Job pop-up
window appears.

Enter a document name that fits the type of document you are adding.

Click the Print button. The Print Now screen appears and the system is ready to receive
the document from another application.
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.

https:#ftraining. providerlink.com - ProviderLink - Print Now - Mozilla Firefox

Close

Print Now

Open the application from which you want to print and select "print” from the application's file dropdown menu.
Frint to the ProviderLink Virtual Printer.

This may take a few seconds.

DO NOT PRESS THE "CLOSE" BUTTOMN OMN THIS WINDCWY UNTIL YOU RECEIVE A MESSAGE SAYING
ITHAT THE PRINT JOB HAS BEEN SUCCESSFULLY SENT

5. Leaving the ProviderLink windows open, open the clinical system that contains the report
and prepare to print it.

6. Change the printer options to print the report using ProviderLink Virtual Printer. The
document will spool to the printer and the ProviderLink Internet Gateway dialog box
appears.

7. After the status bar fills and the o 3
. . ProviderLink Internet Gateway
window displays the message

“The send  completed —
successfully,” click the Close Merl.i ™
button.
8. Minimize or close the clinical
SySte_m i and return to Print Job: Training Manual - Hospitals, odt
PrOVIderLlnk- Internet Destination:  https: [ ftraining. providerlink. comfproviderlinkprintCatcher
9' Close the Print NOW WlndOW The send completed successFully,
The Documents For Patient
screen Wl” refresh and you [IIIIlIIIIIIlIIIIIIlIIIIIIlIIIIIIIIIIIIIIIIIIIIIIIIIIIII
should see the document you
print-attached added the list.
Documents for Patient: McCoy, Julie
| Name & Typesdl __ Facility 4 User ¢ Modified Date | Create Date
1 D CE T Health & Physical Fax Medical_Center kate Miller 07/16/2007 8:27 AM 07/16/2007 8:27 AM
O D D'—_" @ Benefits Summary Print Medical_Center amy Parriss 05/22/2007 2:05 PM 05/22/2007 2:05 PM

[ Move | [ Delete | [ Selectal | [ Unselect &l |

To Add An Electronic Form (E-Form) To A Patient Record:

1. From the View Patient Information screen's menu bar, click Documents to view the
Documents For Patient screen.

2. Onthe menu bar, click E-Forms to view the available forms.
3. Select the appropriate Form Name. The system will display the form you selected.

4. Complete the fields on the E-Form, paying particular attention to the required fields as
indicated by the red asterisks.

5. After completing the form, click Save on the menu bar

6. To have the system check to see if the form's required fields have been completed
correctly, click Check on the menu bar After checking the form, the system will display red
text below the fields to show any errors. Fix the errors and check the form again.

7. Once you are confident there are no errors on the form, click Save on the menu bar
8. To close the form, click Save and Close on the menu bar
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B. Getting A Signature For Your Documents

Through ProviderLink, you have the ability to sign any document, whether added electronically or
by fax attaching. Medicaid and most skilled facilities require a physician's signature for the approval
request form to be valid. Depending on your workflows and practices, you can easily obtain and
process these signatures for your ProviderLink documents.

There are three ways to obtain signatures documents in ProviderLink: 1) electronic signatures
using a physician's user name and password; 2) sending the document to the physician's office
with a bar-coded, fax-back cover page; or 3) printing the form for signature and scanning it into
ProviderLink with a bar-coded cover page.

Once the form is signed, the signature is stored with the document, in the Documents list, and the
form is tagged with the signature icon. When the signed form is transmitted to another facility, a
copy of the original form is attached to the signed form.

C. Electronic Signatures

Because of modern technology and the desire to move to paperless processes, more and more
healthcare organizations will accept electronic signatures on documents. In fact, most of these
organizations have a written policy for electronic signature acceptance. You will need to verify your
organization's electronic signature policy before using it to sign your ProviderLink documents.

To Electronically Sign A Document:
1. From the menu bar of the form or document (screen) you wish to sign, click Signatures [
Electronically Sign. The Add Signature screen appeatrs.

Note: If the Signatures option does not appear on the menu bar, you will need to Save the E-
Form first.

Logout Help

)‘- - i " ™
R 'D‘"dﬁg-j"“ Main Window = McCoy, Julie = Documents = NC Medicaid FL2 = Electronic Signature

Fatient: McCoy, Julie MNC Medicaid FL2 10/10/2005 10:14 AM

e Aarie Morton

¥ |and | attest to the accuracy of this document.

Pazsword:

[ Sigh Document ]

2. Select your name from the | am drop-down list and enter your Password. Click the Sign
Document button.

3. After you enter the correct password and submit the signature, the system will return you to
the form or document you signed. Notice the menu bar now has fewer options.

SaveCopy  Check e Delete  PDF Format Signatures Mote Help  Logout

‘-‘*, ™
Pm‘:-r":l%l:jnk Main Window= McCoy, Julie= Documents=p NC Medicaid FL2

NORTH CAROLINA MEDICAID FL2
LEVEL OF CARE SCREENING TOOL

HIPAA guidelines recommend that healthcare organizations archive a copy of every
| form that is signed or sent to other facilities. Because of this, ProviderLink locks the form
' as soon as it is signed or attached to a message and it may not be altered. When you
need to change the data on the form, you must create a copy of the form with the “Save
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Copy” option on the menu bar and change the form data on the copy. If required, the
new copy of the form will need to be signed.

D. Printing The Document For Signature

After completing a form, you may print the document and attach it to the patient's chart so that the
physician can sign it. With the document, the system will generated a bar-coded cover page that is
used to scan (fax) the signed document back into the patient's document list. The signed document
is archived with the patient's record and can be transmitted to anyone who needs it.

To Print The Document For Signature:

1. From the menu bar of the form or document you wish to sign, click Signatures = Print for
Signature. The system will render the form as a PDF document and you will be asked to
open it using your PDF reader.

Note: If the Signatures option does not appear on the menu bar, you will need to Save the E-

Form first.
If you are using Windows XP with Service Pack 2 installed, Internet Explorer may display
a security message at the top of the page: and prevent the file from appearing:
‘@ \ | 5 To help protect vour security, Internet Explorer blocked this site From downloading files to wour computer. Click here For options... x ‘

If this occurs, simply click the yellow security message and, when the pop-up menu
appears, choose to DOWNLOAD THE FILE.

2. Click the Open button to open your PDF reader and view the file. The first page will be the
bar-coded cover page, followed by the document itself.

F- x||

Do you want to open or save this file?

L PoF Mame: Ffilename, pdf

g

idobe Type: Adobe Acrobat Document, 31.1 KB

Fram:  login, providerlink. com

Open ] [ Save ] [ Cancel

harm your computer. If wou do nat tust the zource, do not open or

@ ‘whhile files from the Intermet can be uzeful, some files can potentially
zave thiz file. What's the nzk?

3. Using your PDF reader's print function (usually File > Print), print all pages of the document
on your desktop or network printer.

4. Place the form where the physician can sign it.

5. Once the form is signed, place the bar-coded cover page on top of the form and fax it to the
number on the cover page. Once the ProviderLink system receives the fax and reads the
bar code, the signed document will appear in the patient's documents list.

E. Sending The Document To A Fax Contact For Signature

If the physician is not in your facility to sign the document, you may use ProviderLink to send the
document to a fax machine for signature. A fax-back cover page is provided so that, after the
document is signed, the physician may fax it back to you through ProviderLink. When it arrives, the
system will automatically route the signed document to the list of documents in the patient's record.
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To Send The Document To A Fax Contact For Signature:

1. From the menu bar of the form or document you wish to sign, click Signatures - Send for
Signature. The Create Message screen appears with the document already attached, the
Subject is completed, and the Request a Reply and Create a Reminder Task check
boxes are selected for you.

Note: If the Signatures option does not appear on the menu bar, you will need to Save the E-
Form first.

2. Click the To Recipients drop-down arrow, and select the appropriate distribution list or
mailbox for the office of the person whose signature you need.

3. If the mailbox does not appear in the drop-down list, you can find it by clicking the Search
button. The Facility Search pop-up window appears.

4. Enter the search criteria.
5. Click Search.

Search Mew Contack Close Help
Search
| Facility Search |

Search For a Facility
Facility Type: Select a Facility Type w
Facility Mame: ||

Unique ID:
Fax Murnber:
Last Name:
First Narme:

Main Phone
Murnber:

City:
State/Province: | Na State Selectad w | Zip:

County: Select a State First b
Show:

6. The Search Results screen displays. Select the recipient from the list and click Save.
7. The Create Message screen returns with the selected recipient in the To Recipients field.
8. Enter an appropriate message Subject (e.g., “Level 1 PASARR").

Online Fax-lﬁnlyr DSystem Fax-only
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Send Templates Frint Help Logout

AR
R m'dﬂ‘f_'-,""* Main Window = McCoy, Julie = Documents = NC Medicaid FL2 = Create Message

Patient: McCoy, Julie DOB: 05051925
— Select Recipients — b

[EHEDREnt= Link &Il Recipients

From Mailbox: tain “

Available Documents: Request a Reply

MNC Medicaid FL2 10/10/2005 10:74 Ak Include Fax-Back Cover Page
(For Fax Only Recipients)

Documents To Attach:

Create & Reminder Task

The message subject is important for several reasons. First, the subject alerts the
recipient to the potential importance of your message. Second, the message subject

s may assist the recipient to route your message to the person or department who can
@ best complete your request. Also, ProviderLink uses your message subject as the link to
/7 \ open the message and displays it in the Message History. A descriptive subject should
give users an idea of what the message contains without having to open the message
itself.

9. If necessary, enter a message in the Message field.

10. If there are any required form fields that have not been filled in or formatted correctly, you
will see red error messages highlighting the errors. To fix the errors, you will need to return
to the form by clicking Form Name (e.g., NCMedicaidFL2) in the breadcrumb trail.

Available Documents:

Documents To Attach:

Subject:

Request a Reply

MCMedicaid FL2 10/10/2005 10:14 Akd Include Fax-Back Cover Page
(For Fax Only Recipients)

Create a Reminder Tazsk

The form "HC Medicaid FL2 10102005 10214 AM' has the following errors.
Requested Care Level iz a required field.

Patiert County Mumber iz a reguired field.

Current Setting iz a required field.

Medicaid ID Mumber iz a required field.

PASARR Mumber iz a required field for this care level.

At least one Medication should be entered (or enter 'none’).

Phyysician First Mame is a reguired field.

Physician Last Mame is a required field.

Signature Reguested
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11. When you are ready to send the message, click Send. The system will send the document
for signature, create a reminder task (to remind you that you are waiting for a signature),
and return you to the form screen.

When the physician signs the document and faxes it back using the bar-coded, fax-back,

s cover page, ProviderLink will read the bar code and route the signed document to the
\ patient's record. You will see an unread message for that patient appear on your work
A list. When the signed document arrives, the system will also mark the reminder task as
complete.
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F. Sending Referrals To Other Facilities

Most hospitals use an E-Form as a referral tool and transmit it to other facilities to seek placement
for their patients. ProviderLink makes the referral process easy, as hospitals can choose to send
the referral form and supporting documentation to a single facility or broadcast the information to
several facilities at once using distribution lists.

Because ProviderLink can send messages to fax contacts as easily as online contacts, the
discharge planner may use the same Create Message screen for either type of contact. Fax
contacts will receive the ProviderLink message on their fax machine and, when you request a
reply, can respond using a bar-coded, fax-back cover page. ProviderLink online contacts will
receive the message electronically as an unread message in their work list and can respond to you
electronically through ProviderLink. When either type of contact replies, you will receive the
response as an unread message attached to the patient record in your work list.

To Send The Referral Message:

1. From the View Patient Information screen menu bar, click Send Message. The Create
Message screen appears.

Send Templates Print Help Logout

PréviderLink - Mai ; ;
roviderl) Main Window = Arrington, Regina = Create Message

Patient: Arrington, Regina DOB: 12/08/134%
- Select Recipients - V
U e Link &Il Recipients

2. Select the message recipients from whom you are requesting placement.

a. From the Select Recipients drop-down list, select the appropriate distribution list. The
distribution lists may be arranged by county, geographic area (e.g., 50-mile radius, etc.),
or specialty (e.g., SNF Vent, SNF Dialysis, etc.).

Send Templates Print Help Logaut |

providerLink . Mai ' i
(oY ‘r_,f Main Window = Arrington, Regina =» Create Message

Patient: Arrington, Regina DOB: 12/08/194%
- Select Recipients - v
To Recipients: = - SelectRecipients — Link ANl Fiecipients

MCGeneralHospital - Case Management - Online
Medicaid-MCPASARR - Main - Online
Medicaid-MCFL2 - Main - Online

SMNF Trach faciliies

SMF Wake County

SW FL2 Prior App Req

- . SW Pasar Reauest —

From Mailbox:

b. If there is no distribution list that contains the desired facility(ies), you may need to
search for the recipient(s).
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Search Mew Contack Close Help
Search
| Facility Search |

Search For a Faciliby
Facility Type: Select a Facility Type w
Facility Mame: ||

Unique ID:
Fax Mumber:
Last Name:
First Narme:

Main Phone
Murmber:

City:
State/Province: | Na State Selected w | Zips

County: Select a State First b

Show: ¥ oinline Fax-DnIy DSystem Fax-Cnly

i. Click the Search button. The Facility Search pop-up window appears.

ii. Choose the type of facility for which you are searching from the Facility Type drop-
down list (e.g., Skilled Facility).

iii. If you are looking for a specific facility, type in the first few letters of the Facility
Name.

It is generally not recommended that you enter the entire facility name in the “Facility
Name” field when searching for recipients. ProviderLink will look for exactly what you
\@ enter as search criteria. If you spell the facility name differently than it appears in your
3 system, ProviderLink will not find the facility. For this reason, enter only the first few
letters of the facility name. This way, you have the best chance of finding the facility, if it
is already set up in your system.

iv. If searching for all of the facilities in a city, zip code, county, or state, use the City
and Zip Code fields or the State/Province and County drop-down lists to narrow

your search by geographic area. If searching by county, you will need to select the
state first.

v. When you have finished entering search criteria, click the Search button to view the
Search Results.

Save Mew Contact Close Help
Search Results for Patient: McCoy, Julie

21 Total, 1 of 1 page(s) crate | 2

L Mailbox Name Facility Name - | First Name = | _Last Name | Unigue ID | Fax Number | City | _ County __[State| Zip |
[0 radiclogy Hilltop Assisted Living Radiology 555-555-1212 BRUNSWICHK M
Center

[0 Admissians Hilltop Assisted Living Admissions 555-555-2242 BRUNSWICHK M
Center

vi. The Search Results are listed in alphabetical order by the facility name. If you do not
see the facility for which you are searching, click Close on the menu bar to try your
search again by repeating the steps above.
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vii. Select the mailbox which you want to send the message by clicking the check box
for the mailbox.

viii. Once you have selected the mailbox(es) to which you will send the message, click
Save on the menu bar to add the mailboxes to the list of message recipients.

ix. If, after searching for a fax-only facility, you are unable to find the facility and are
certain it does not exist in your system, your facility administrator will need to create
the facility and contact mailbox in your system before you will be able to send the
message to that facility's fax machine. Online facilities are automatically added to
ProviderLink as they become ProviderLink subscribers.

Note: Once a facility is created by the facility administrator, users can add fax-
contacts from the Add/Edit Contact Mailbox screen.

3. Attach the referral form and the necessary supporting documentation to include with your
request.

a. From the Select a Document drop-down list in the Available Documents section, select
the referral form and any other document you wish to send to the message recipients.
Once selected, the document appears in the list of Documents to Attach. You must
select each document individually.

When sending a referral to more than a couple of facilities, send limited information such
as a referral form and face sheet. If a facility responds that they have bed availability,
@ then you can send more detailed clinicals such as an H&P. Sending a smaller referral
\ packet will save your facility money by reducing the number of fax pages used. It should

also transmit the referral faster since fewer pages will need to be sent to each recipient.

b. To remove a document from the list of Documents to Attach, double-click on the name
of the document.

4. Enter your message Subject (e.g., “Placement request”).
5. Enter your Message text.

a. You may wish to enter any other information that might assist the recipients in
evaluating your request or is not included elsewhere in the message or supporting
documentation.

b. You may use a template to add standardized wording to help complete your message if
available.

i. From the menu bar, click Templates to view the list of available templates. Your
facility administrator can create templates for you.

ii. Templates simply add frequently used wording to your message and you may edit
or add to the message as necessary.

6. Request a reply from your message recipients.
a. Click the Request a Reply check box.

Available Documents: —-Selecta Document — w Request a Reply

MNC Medicaid FL2 10/10/2005 10:14 AM Include Fax-B ack Cover Page
[For Fas Only Recipients)

Create a Reminder Task

Docurnents To Attach:

b. To enable fax contacts to reply to your message, you will need to leave the Include
Fax-Back Cover Page check box selected.

c. You will most likely wish to remove the check mark from the Create a Reminder Task
check box if you are sending the message to several fax contacts.

7. Once you are satisfied with your message, click Send.
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The “Create a Reminder Task” option, when selected, creates a reminder task in your
work list for each message recipient included in the outgoing message. It is as if to say,
“Create a reminder task to remind me that | am waiting for a reply from each of the
message recipients.” Each reminder task is removed only when the recipient responds
to your message or you withdraw the request. While online contacts must reply to your
message before they may remove the patient from their work lists, fax contacts are not
\@ systematically required to respond.
\

While creating reminder tasks may seem desirable, it is unrealistic to assume that each
of the message recipients that are fax contacts will use the fax-back cover page to reply
to your message. If the recipient fails to reply within a specified time frame (usually 24
hours), an alert is triggered notifying you that you have not yet received the reply. You
will then need to remove each request and clear the associated alert before you can
remove the patient from your work list.

G. Processing Incoming Messages

As stated earlier, ProviderLink uses a single interface to send messages to both online and fax
contacts. Once you send the message, ProviderLink sends the message to online contacts
electronically and sends a fax transmission to fax contacts.

Once they receive your request, either type of contact can reply to your message in the same way
they received it. Online contacts can send their reply as an electronic message that will be
attached to the corresponding patient message. Fax contacts will send their replies using the bar-
coded, fax-back cover page, which ProviderLink will convert to an electronic message and attach it
to the corresponding patient record. In other words, replies to your requests will appear as unread
messages attached to the patient record.

You may access and read incoming messages using several methods, though it is usually
recommended that you first navigate to the View Patient Information screen and then read the
incoming messages.

To Process Incoming Messages:

1. From the Main Window List Summary, click Unread Messages to change to the Current
View: Unread Message List. The list of unread messages is sorted in order by date and
time received with the oldest message at the top. You may click any of the green column
headers to re-sort the list.

MHew Lookup Setup Repaorts Frint Refresh Help Logout

Facility: providerlink
View: SteveGroup
User admin

Fro'.#derl.inki'" Unread Patietits: 2 Tasks: 0
Messages: Reviews Dus: 0 Ailerts: 0

Current View: Unread Message List
1 Total, 1 of 1 page(z) ) ) )

[ _Patient= [ - | __ Date” | From - [ To- | _Subject> ]

MCoy, Julie MR 234067 01/04/2006 216 A Breezybrook bAores - providerlink - Main  RE; Placement Heguest 1

2. Click the Patient link to access the View Patient Information screen for the patient whose
message you wish to read.

3. In the Status section in the bottom left corner, click the Unread Messages link. The Unread
Messages For Patient screen appears, showing you the list of unread messages, sorted by
date and time, with the oldest message appearing first.

You may navigate directly to the unread message by clicking the “Subject” link.
“‘~@ However, the breadcrumb trail will only reflect the steps you took to read the message
/4" (Main Window > Read Message) and you will not be able to navigate to the associated
; patient's View Patient Information screen to access any of the patient's information
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without first returning to the Main Window.

By navigating to the View Patient Information screen and then the Unread Messages For
Patient screen, the patient's name is added to the breadcrumb trail (Main Window >
Patient Name >Unread > Read Message). This enables you return to the View Patient
Information screen to continue processing the patient's record.

4. Click the Subject link of the message you wish to read. The message appears. The
message header shows you who the message is from, the mailbox the message arrived
through, the date and time the message arrived, whether or not the sender requested a
reply (i.e., if an online contact), who read the message and when, the message text, and
the names of the attached documents.

Reply Farward Resend Mark Unread Cantact Auth Print Help Logaout

P i« ow=p ew e e
t.' i ""' -;

View Message for Patient: McCoy, Julie
DOB: 12/11/1948

To: Facility: Medical_Center From Facility: Medical_Cente
Mailbox Mame: Main Mailbox: Mailbox Mame: Main
Other Reference: User: Kate Miller
Connection: Online Unigue ID: MR1Z234567
Reference:
077162007 1:23 PM Mo reply requested by sender

Message Status: Sent

Attached Documents:

MNC Medicaid FLZ 07/16/2007
11:35

Subject: RE: Placement Bequest

Message:

5. Click the Attached Documents links to open the attachments. ProviderLink will open the
attachment using the appropriate viewer.

)‘ - . "'l ™
F': lDVldE‘r_l-,mk Main Window = McCoy, Julie = Unread = Read Message = Attachment Viewer

Patient: McCoy, Julie
Zoom In | Zoom QOut | Rotate Left | Rotate Right | Flip
JEH-RA SR 00T Fromifroyviderbinks , I0f: (i wwww woows.ws s wasa FOES % UL W
rax ack covER PAGE [ I I0LN) 10 L
FAX TO 1-800-563-9620 MMV
Please use this cover page to fax your reply. The bar code
routes your reply back to me.

6. If necessary, print the document.

a. To print the page you are viewing, click Print Page on the menu bar. The Print dialog
box appears, allowing you to choose your printer.

b. If you wish to print the entire document, click PDF Format on the menu bar.

i. Depending on your operating system and PDF document reader (if installed), you
may see a dialog box appear asking you whether you want to open or save the
document. If the dialog box appears, click the Open button.
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S

File Download

Do you want to open or save this file?

m- MName: filename.pdf
st Type: Adobe Acrobat Document, 18.5 KB

From: login. providerlink. com

Cpen ][ Save ]| Cancel |

While files from the Intemet can be useful, some files can potentially
harm your computer. f you do not trust the sounce, do not open or
save this file. What s the gk 7

ii. When the document opens in your PDF reader application, use the application's
print instructions to print the document.

iii. After the document prints, close the PDF reader and return to ProviderLink.

7. When you are finished working with the attached documents, you may click Read Message
in the breadcrumb trail to return to the message and send a reply. Use the same guidelines
as outlined beginning on Page 36 to format and send your reply.

H. Managing Your Work Lists

Patient records are often moved through a workflow. Tasks and patients can be easily moved from
one work list to another and so on to complete a workflow. When a patient is moved from one work
list to another, all of the properties of that patient such as tasks, overdue items, etc., move to the
new work list. So if a patient is moved, for example, from one unit to another in a hospital setting,
all of that patient's open tasks and overdue items are automatically added to the new case
manager's work lists. The new case manager can also see all related documents, forms,
communication histories, authorizations, open communication requests, etc.

After your portion of the patient's workflow is complete, you may remove a patient from a work list.
The system will display a message if the patient record has any unread messages, incomplete
tasks, or overdue items. If yours is the last work list linked to the patient, you will need to process
all outstanding items (i.e., all unread messages and undone tasks) before removing the patient
from your work list.

To Link Another Work List To The Patient Record:

1. From the View Patient Information screen, locate the Linked Work Lists section in the
center of the screen.

Linked Work Lists
All Available Yyork Lists: Add YWark Lists Linked to this Patiert: *

Admisgions M Intake ~
Discharge Flanning LR Angie Able

Cutpatient Services

UR Clara Capahle w v
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2. Select the work list you wish to add from the All Available Work Lists list box and click the
Add button. The chosen work list will be added to the Work Lists Linked to this Patient
list box.

3. On the menu bar, click Save. The system saves the patient record and adds it to the linked
work list(s).

To Remove A Work List From The Patient Record:

1. From the View Patient Information screen, locate the Linked Work Lists section in the
center of the screen.

2. Select the work list you wish to remove from the Work Lists Linked to this Patient list box
and click the Remove button. The chosen work list will be removed from the Work Lists
Linked to this Patient list box.

3. On the menu bar, click Save. The system will check to see if there are any unread
messages and incomplete tasks and, if there are, it will display an Open Items message.
Review the message and click the Remove button.

Help
The following items are open for patient: McCoy, Julie
Unread Messages: z
Taslks: z
Patient Status: Adrnitted

Are you sure you want to rermove this patient?

( Remove | ( Cancel |

4. If there are no other work lists linked to the patient record, the system will not allow you to
remove the work lists and will display a message. Click the Continue button to return to the
patient record and close the outstanding items.

5. Once the patient is removed from the work list, the updated work list appears with the
remaining patient records.

3. Virtual Fax Service

ProviderLink Virtual Fax Service (VFS) enables you to forward a fax line and receive all incoming
faxes as imaged documents, which are processed and stored online. This provides a single
interface and workflow for all your incoming fax and online communications.

In ProviderLink, all incoming faxes to your facility are directed to an “incoming fax folder” then
processed using the Document Viewer screen. The options and features on the Document Viewer
screen are used to process incoming faxes by moving them to other folders or by attaching them to
a message addressed to a mailbox within your facility. Options on the screen also allow a fax to be
split into separate documents, renamed, and processed in a single step.

The manner in which a fax is processed depends on the type of folder in which the fax is stored.
There are two types of fax folders in ProviderLink: 1) Messages and 2) Folders. Your incoming fax
folder will be set up in the manner that best fits your workflow for receiving fax messages. With
either type of folder, you have the ability to add metadata information to a document. Once a
document is stored with metadata, you may use that information as search criteria to make it easier
to find the document later.
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A. Message-Type Folder

The Message type is the most commonly used. Considering that an incoming fax is a type of
message from an outside sender to someone in your facility, this workflow is best completed using
a Message folder type. This type enables you to add the fax document to a patient record and
route the incoming fax message to one of your facility's mailboxes and its associated work list.

After the fax is routed, the person or department to which the fax is sent will see an unread
message linked to the patient record. Since the fax document is attached to a patient record, it is
then available to be attached to a message and sent. This workflow works best when the majority
of incoming faxes are related to patients.

To Process An Incoming Fax (Message Workflow):

1. Be sure you are viewing the Incoming Fax Folder Main Window. You will see a list of the
faxes received with the oldest faxes on top.

Mew Lookup Setup Reports Print Refresh Help Logout

Facility: ProviderLink

Pmﬁar‘.iﬂkﬁm View: Providerlink Default Incoming Fax
User: km
Get Mext Fax
& Total, 1 of 1 page(s) R B

| MName<+ __[Type>| ___ Facility= | ___ User= | Modified Date - Create Date =

| D Dg @ Fax From 9191234565 Fax Incoming Fax Daermon  Incoring Fax Daemon 117102006 1:30 PM 111072006 1:30 PM
IF] D DE(L @ Fax From 9191234567 Fax Incoming Fax Daemon  Incoming Fax Daemon 11/21/2006 2:28 PM 11/21/2006 2:28 PM

2. You will normally want to process the oldest document in the list. To view the oldest
document, click the Get Next Fax button. The fax message will appear in the Document
Viewer screen.

FDF Format Moy e Delete Print Page Mote Help Logout

A TG 'I‘H.'—} D HTTR Nt rewel
lel{hl!—“lk C C

Document Information: Received: 1/25/07 2:52 PM From: 919-123-4563
Originator:* "

Page(s)¥ Document Mame Category Patient® Mailbox*
Al Faw From 9191234563 Order » || Choose a patient W
Procedure Date: I:lF‘rcu:edure Type: Status:

Rermove document from fax queue,

| Save || SaveandMest || Save and Reply |

Zoom In| Zoom Out | Rotate Left | Rotate Right | Flip

3. Above the fax document image, notice the image control links (i.e., Zoom In, Zoom Ouit,
Rotate Left, Rotate Right, and Flip). If the fax message contains more than one page, you
will see a numbered link for each page.

4. ProviderLink will try to recognize the number from which the fax was sent and display the
facility name in the required Originator field. If the Originator field is blank, the system
does not yet have the fax number stored. If the Originator is not recognized, you will need
to search for or create the fax contact.

a. Click the Search button to the right of the Originator field. The Facility Search screen
appears.

b. Using the guidelines in the “To Send a Referral Message” section, search for the facility
that sent the message. If the facility does not exist, your facility administrator can add it
to the system.
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If there are multiple pages, view each page to determine if the message contains
documents for more than one patient.

a. If all the message pages relate to one patient record, accept the default “ALL” value in
the Page(s) field.

b. If the message contains pages for more than one patient, click the More button to add
another set of routing fields. Then, enter the appropriate page number or page range
(e.g., 1-3) in the Page(s) field.

In the Document Name field, enter the type or name of the document.

Search for the patient to associate the fax document. Click the Search button to the right of
the Patient field. The Patient Lookup screen appears.

Use the guidelines in the “To Create a New Patient Record” section to search for or create
a new patient record.

Choose the mailbox to route the fax document.

You may add additional information in the “metadata” fields. In this example, additional
information can be added in the Status, Procedure Type, and Procedure Date fields. This
will aid users when searching for this document.

Once you have completed all of the required fields, you may choose how you wish to save
the document(s).

a. The "“Remove document from fax queue” check box is selected for you automatically.
This means that, when you choose one of the save options, the fax message will be
removed from the list. Remove this check mark to leave the fax message in the queue.

b. The “Save” button will process your routing options and return you to the same fax
message for further processing.

c. The “Save and Next button” will process your routing options, close the fax message,
and open the next oldest one in the incoming fax folder. You will use this option most
often when processing multiple fax messages.

d. The “Save and Reply” button will process your routing options, close the fax message,
and address an outgoing message to the sender of the fax. This enables you to request
additional information from the fax originator.

B. Folder-Type Folder

The Folder type allows you to store documents without requiring you to link them with patient
records. This workflow allows you to store documents in folders for easy access. You have the
option of saving the fax to a patient folder or a more generic document folder. One limitation of
documents that are not linked to patient records is that they may not be attached to messages or
sent using ProviderLink.

Metadata is defined, most literally, as “data about data” or information known about the fax
message in order to more easily find the document. Once a document is stored with metadata, you
may use that information as search criteria with which to find the document later.

To Process An Incoming Fax (Folder):

Be sure you are viewing the Incoming Fax Folder Main Window. You will see a list of the
faxes received with the oldest faxes on top.

You will normally want to process the oldest document in the list. To view the oldest
document, click the Get Next Fax button. The fax message will appear in the Document
Viewer screen.
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Pagelz[* Document Marme Cateqory Patignt Folder
Fax From 919 465 1481 Order |» |Choose a patient [ Search ” Clear] w [More ]
Status: Procedure Type: Procedure Date: D
3. ProviderLink will try to recognize the number from which the fax was sent and display the

facility name in the required Originator field. If the Originator field is blank, the system
does not yet have the fax number stored. If the Originator is not recognized, you will need
to search for or create the fax contact.

a. Click the Search button to the right of the Originator field. The Facility Search screen
appears.

b. Using the guidelines in the “To Send a Referral Message” section, search for the facility
that sent the message. If the facility does not exist, your facility administrator can add it
to the system.

The only field that is required is Page(s). If there are multiple pages, view each page to
determine if the message contains documents for more than one patient.

a. If all the message pages relate to one patient record, accept the default “ALL” value in
the Page(s) field.

b. If the message contains pages for more than one patient, click the More button to add
another set of routing fields. Then, enter the appropriate page number or page range
(e.g., 1-3) in the Page(s) field.

In the Document Name field, enter the type or name of the document.

Instead of choosing a mailbox, you have the choice of linking the document to a patient
record or a folder.

a. To link the document to a patient record, search for the patient to associate the fax
document. Click the Search button to the right of the Patient field. The Patient Lookup
screen appears. Use the guidelines in the “To Create a New Patient Record” section to
search for or create a new patient record.

b. To link the document to a folder, select the folder from the Folder drop-down list.

You may add additional information in the “metadata” fields. In this example, additional
information can be added in the Status, Procedure Type, and Procedure Date fields. This
will aid users when searching for this document.

Once you have completed all of the fields, you may choose how you wish to save the
document(s).

a. The “Remove document from fax queue” check box is selected for you automatically.
This means that, when you choose one of the save options, the fax message will be
removed from the list. Remove this check mark to leave the fax message in the queue.

b. The “Save” button will process your routing options and return you to the same fax
message for further processing.

c. The “Save and Next button” will process your routing options, close the fax message,
and open the next oldest one in the incoming fax folder. You will use this option most
often when processing multiple fax messages.

d. The “Save and Reply” button will process your routing options, close the fax message,
and address an outgoing message to the sender of the fax. This enables you to request
additional information from the fax originator.



Section 3 Summary
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After this demonstration of how the ProviderLink system assists you in your daily work, you should
know how to:

Utilization Review

link payor contacts to a patient record
change the patient's status

create a task for reminder or review
add documents to patient records
send reviews to payors

process payor responses

manage your work lists

Discharge Planning

add documents to patient records

access, complete, and process referral forms
print or send documents for signature
electronically sign documents

send requests for patient referrals

process incoming messages

manage your work lists

Virtual Fax Service

« process incoming messages with messaging and folder workflows
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Section IV - Appendices

Appendix A — Troubleshooting ProviderLink Issues

This section describes how to troubleshoot issues encountered while using ProviderLink. The table
below lists common ProviderLink functions and respective issues, the steps you can take to
resolve the issue, and some explanation of why the issue occurred. Most issues can be resolved
using the instructions cited in this guide and the references to the appropriate sections are noted in

the “Steps To Resolve” where appropriate.

Issue

Function

Unable to log into
ProviderLink

The ProviderLink Login
screen does not appear.

| forgot my password
and/or user ID.

I've been suspended.

Steps To Resolve

Can you access other
websites (e.g.,
google.com, etc.)?

Are you trying to
access the correct web
address?

Go to the Covisint login
screen
(https://healthcare.covis
int.com) and click
“Forgot your
password?” or “Forgot
your User ID?”

If you enter an incorrect
password 5 times
within 5 minutes, your
Covisint-ProviderLink
account will be locked
due to an excessive
number of invalid login
attempts.

Go to the Covisint login
screen
(https://healthcare.covis
int.com) and click
“Forgot your
password?”

What To Do Now

Yes — Contact the
ProviderLink Help Desk to
determine if there are any
system issues.

No — Contact your IT
network staff to determine
if your facility is having
network or Internet issues.

Be sure you are entering
https://healthcare.covisint.
com into the web
browser's Address bar.

For password, enter your
User ID and answer your
challenge question to
reset your password.

For user ID, enter your
email address, and your
user ID will be emailed to
you.

In order to unlock your
account, simply use your
challenge question and
answer to reset your
password. Or your Facility
Administrator can
unsuspend your user
account.

Patient Records | can't find the patient
record | was working

with.
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Search for the patient
record using the Patient
Lookup feature.

ProviderLink saves patient
records indefinitely.
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Function

Messaging

Documents
Management

Issue

| sent a message to a
facility. How can | be
sure it was received?

Steps To Resolve

Check the History
Items for the patient.

What To Do Now

The History Items list
records every incoming
and outgoing message for
the patient and whether or
not a message is sent
successfully.

A message | was
reading isn't in the
Unread Messages list.
Where can | find it?

Check the History
Items for the patient.

Once you've read a
message, it is removed
from the Unread
Messages list.

| faxed my document 20
minutes ago and | don't
see it in the patient's
Documents list.

| don't see the
ProviderLink Virtual
Printer in my list of
printers.

The ProviderLink Printer
gives me an error
message: “Please attach
a case within
ProviderLink before
attempting to print.”

Look for the document
in your facility's
Incoming Fax Folder.
Route the document to
the appropriate folder.

You must install the
ProviderLink Virtual
Print Driver before you
can print attach any
documents.

Print attach a document
into a ProviderLink
patient record.

Also, contact
ProviderLink Customer
Support for newest
version of the Virtual
Print Driver.

When ProviderLink is not
sure where to route a
document, the system will
route the document to the
Incoming Fax Folder.

The ProviderLink Virtual
Print Driver can be
downloaded and installed
from the Help menu on
the Main Window.

You must first start in the
patient's record and
choose to add a
document by print job
before printing using the
ProviderLink Virtual
Printer.
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Appendix B — ProviderLink Quick Reference Guide

ProviderLink Quick Reference Guide

To Log Into ProviderLink:

1. In the IE window Address bar, type https://healthcare.covisint.com and press the Enter key.
The Covisint login screen will appear.

2. Enter your User ID and Password.

Click Login. The Covisint Healthcare home page displays. In the left-hand menu, under
Secured Applications, click ProviderLink to launch the application, which opens in a new
window.

To Unsuspend Your ProviderLink Account:

49

If you try to log in and fail 5 times in 5 minutes, the system will suspend your user account and you
will need to reset your password. In order to unlock your account, simply use your challenge
question and answer. This will automatically unlock your account.

1. From the https://healthcare.covisint.com page, click “Forgot your password?.”

a. The screen expands displaying a field to enter your User ID and then click Submit. The
Reset Password screen displays.

b. Enter the answer to your challenge question in the Challenge Answer field and click
Submit.

c. Upon successful submission, the first half of the password displays on the screen, while
the second half is sent to email address you submitted during the registration process.

2. Alternatively, you may contact your facility Security Administrator to request that he/she
perform the password reset and unlock your account.
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To Check ProviderLink For And Read Incoming Messages:

10.

Once logged into the system and viewing the Main Window screen, click the View link in the
top right corner.

Click the View drop-down arrow and choose your Work List.
Click Submit to display your Work List. The Main Window screen will appear.

When viewing your work list, the number of Unread Messages will appear at the top of the
screen and in the Unread column in the patient list. Clicking either of these numbers will
display the message list.

To read a message, click the patient's name link in the Patient column.

When the View Patient Information screen appears, click the Unread Messages link in the
Status section in the bottom right corner.

When the Unread Messages for Patient screen appears, you may read a message by clicking
the Subject link. The message will appear on the Read Message screen.

From the menu bar, you may Reply, Forward, Mark the message Unread, view information
about the sender Contact, and Print the message.

If there are any Attached Documents, you may click the links to read the attachments.

To go back and read more unread messages, you may click on Unread Messages or the
patient's name in the breadcrumb trail at the top of the screen.
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To Process An Incoming Fax Message:

10.

11.

From the Default Incoming Fax Folder screen, click the Get Next Fax button. The first page of
the fax message appears.

Once you determine which provider the message is from, click the Originator drop-down list to
see if the provider appears. If so, select the provider.

If the provider is not in the Originator list, click the Search button to bring up the Facility
Search window.

Enter the necessary criteria to search for the provider and click Search. The system will
display the search results based on the criteria you specified. If the provider you are searching
for does not appear, modify the search criteria and repeat the search.

If the provider still does not appear, you may need to create the facility.
See “To Create a New Fax-Only Facility.”

Identify the type of document and enter it into the Document Name field.

Next to the Patient Name field, click Search. Use the Patient Lookup window to find the patient
record. If no patient record exists, you may need to create a new one.
See “To Create a New Patient Record.”

Click the Mailbox drop-down arrow to display the list of mailboxes to route the message.
Choose the appropriate recipient's mailbox.

For multi-page fax messages, click the page numbers to check if multiple messages were sent
in the same transmission. If so, you will need to split the message and route each part
separately. To set up the split, click the More button to bring up a new row for each message
part. The Document Name, patient Name, and Mailbox will carry forward to each new row and
may need to be changed.

In the Pages field, enter the pages to send for each message part. For all pages, accept the
default “All” value.

Once you have filled in all of the fields for each message part, make sure Remove document
from the fax queue is selected and click the Save and Next button to pull up the next fax
message.

To Create A New Patient Record:
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From the Patient Search Results window, click New on the menu bar. The Add/Edit Patient
Information screen appears.

Fill in, as a minimum, the patient's Last Name, First Name, and Birthdate in the respective
required fields. You do not have to select a work list.

Click Save. The patient's name will appear in the Patient field.
Note: This also works from the Main Window screen (New > Patient).
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To Create A New Fax-Only Facility:

1. From the Main Window, click Lookup > Facility. The Search window displays. Click New on the
menu bar. The Add/Edit Fax Facility Information screen appears.

2. Enter name of the provider in the Fax Facility Name field, which is the only required field.
If needed, enter the: Main Phone Number; City; State/Province; Zip; and County.

Choose the type of provider from the All Facility Types list box and click Select. There may
be more than one applicable provider type. If you have added a facility type and want to
remove it, you may highlight the facility type and click Unselect.

5. When you have checked your entries for accuracy, click Save.

To Add Documents To A Patient Record With The Virtual Printer:

1. Start from the patient's View Patient Information screen, and click Documents on the menu
bar.

2. When the Documents screen appears, click Add Document on the menu bar, and then select
Add By Print Job from the drop-down list.

3. When the Add a Print Job window appears, enter a name in the required Document Name
field.

4. Click Print. The Print Now window appears and the system is ready to receive the document.
Without logging out of ProviderLink, open the document you wish to print.

6. For most applications, click File = Print, select “ProviderLink Virtual Printer” from the list of
printers, and click Print..

7. The ProviderLink Internet Gateway window will appear and the document will be sent to the
patient record. When you see “The send completed successfully” message, click the Close
button.

8. Minimize the document window to get back to the ProviderLink Print Now window and click
Close.

9. Navigate back to the ProviderLink window (look for the “Documents Management” button on
the task bar) and the document will appear in the list.

10. You may click the Document Name link to ensure the authorization was added successfully.
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To Add A Paper (hard copy) Document To A Patient Record
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1. Start from the patient's View Patient Information screen, and click Documents from the menu
bar.

2. When the Documents screen appears, click Add Document on the menu bar and then select
Add By Fax from the drop-down list.

3. When the Add a Fax screen appears, type a Document Name and click Print.

4. You will see a bar-coded cover page appear. Click Print from the menu bar and print the
document to your printer.

5. Take the bar-coded cover page, PUT IT IN FRONT of the document you wish to add, and fax it
to the number on the cover page. After the fax sends the document to ProviderLink, the
document will appear in the patient's list of documents (i.e. on the Documents screen).

Note: It may take a few moments for the document to appear in the patient's documents list,
depending on the number of pages in the fax message.

Send A Message Through ProviderLink

1. Start from the patient's View Patient Information screen, and click Send Message from the
menu bar. The Create Message screen appears.

2. Select the provider name from the To Recipients drop-down list. If the provider does not
appear in the list, you may search for the facility in the same way as in “To Process an
Incoming Fax Message” steps 3-5.

3. The From Mailbox should already be set for you.

Click the Attached Documents drop-down list to select the documents you wish to attach.
Note: When including an attachment to a message to a fax-only facility, only documents saved
as PDF or TIF files (i.e., faxes) can be sent. If other file types are attached (e.g., Word doc, text
file, Excel spreadsheet, etc.), a warning will display stating that this file type cannot be sent to a
fax-only facility.

5. Enter an appropriate Subject, which will appear on the fax cover page. For example, “OP
Requisition.”

6. You may enter a Message that will appear on the fax cover page. You may also choose to use
a Template to enter a standardized Message.

7. If you want the recipient to reply, click the Request a Reply check box. You may want to
deselect the Create a Reminder Task check box if you do not wish to be reminded you are
requesting a response.

8. Click Send. The message will be delivered to the recipients you specified.

View Another Work List

1. Start from the Main Window screen and click the View link in the top right corner (it will say
“View” followed by the work list name). The Choose Work List View screen will appear.

2. Click the View drop-down arrow to display the list of work lists and folders available for your
organization.

3. Select the work list you wish to view.
Click the Submit button to view the work list.
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To Set A Reminder Task On A Patient Record
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Start from the patient's View Patient Information screen.
In the bottom left corner in the Status section, click Tasks. The Tasks screen appears.
On the menu bar, click New. The Add/Edit Scheduled Task screen appears.

Enter the task Description and Due Date. You may use the calendar pop-up window by
clicking the calendar icon .

In the Non-viewable Comments field, you may enter any special instructions or other
comments regarding this task.

Click Save to save the task and set the reminder. You will return to the Tasks screen.

To Complete Or Delete (remove) A Task

Start from the patient's View Patient Information screen.
In the bottom left corner in the Status section, click Tasks. The Tasks screen appears.

Find the task you wish to complete and click the Description link. The Add/Edit Scheduled
Task screen appears for that task.

a. To COMPLETE the task, click Complete on the menu bar and then select either With
Notes or Without Notes. If you chose to complete the task with notes, enter the notes in
the Viewable Comments field and click the Complete Task button.

b. To DELETE the task, click Delete on the menu bar and then select either With Notes or
Without Notes. If you chose to delete the task with notes, enter the notes in the Viewable
Comments field and click the Delete Task button.

After completing or deleting the task, you will return to the Tasks screen.

To View A Patient's Message History And Audit Trail

Start from the patient's View Patient Information screen and click History Items to view the
Message History screen and every message sent or received relating to that patient.

To view a message, click the message Subject link.
Clicking History in the breadcrumb trail will take you back to the Message History screen.

For a more detailed record of the patient record history, click Audit Trail on the menu bar. This
will show you a detailed history of virtually every activity regarding the patient record including
what occurred, when it occurred, and the associated user name and patient record.

To Remove A Patient Record From Your Work List:

A w b ke

Start from the patient's View Patient Information screen in the Linked Work Lists section.

In the Work Lists Linked To This Patient list, select your work list name and click Remove.
When the system asks you to confirm, click Remove.

The system will display your updated work list with the patient record removed.
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To Log Out Of ProviderLink:

1. From almost any screen, click Logout on the menu bar.
2. After you have successfully logged out, you may close the browser window.

Note: Be sure to log out before you close the browser window to prevent any unauthorized access
to protected healthcare information.

To Get Help:
1. Check the online help — click Help on the menu bar.
2. Read the User Training Manual.
3. Contact YOUR facility administrator.
4. Contact the ProviderLink Help Desk at 866-373-0878 or email support@providerlink.com.
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